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Micro Focus Enterprise Developer 9.0 for
Eclipse Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus Customer Support Documentation
Web site for any documentation updates.

Product Overview

Upgrading from earlier Micro Focus products

Note: Windows-only.

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Eclipse, Enterprise Developer can automatically relink existing projects created with
Enterprise Developer earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the
Problems view that the project requires relinking. It then offers a Quick Fix action for you to execute that
will link your project with the most recent version of the Run-Time System.
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What's New
This What's New? document covers some of the new features and functions in the latest release of the
Micro Focus Enterprise Product Suite. Updates apply to the following products:

• Micro Focus Enterprise Developer which provides a contemporary development suite for developing
and maintaining mainframe applications, whether the target deployment is on or off the mainframe.

• Micro Focus Enterprise Test Server which provides a comprehensive test platform that takes
advantage of low cost processing power on Windows environments, to supply scalable capacity for
testing z/OS applications without consuming z/OS resources.

• Micro Focus Enterprise Server which provides the execution environment to deploy fit-for-purpose
mainframe workload on Linux, UNIX and Windows (LUW) environments on IBM LinuxONE (IFLs),
standalone servers, virtual servers, or the Cloud.

• Micro Focus Enterprise Server for .NET which provides the execution and modernization platform to
deploy fit-for-purpose mainframe workload on a scale-out .NET infrastructure and the Azure Cloud.

This document helps you to quickly understand the new capabilities within the 9.0 release.

Enhancements are available in the following areas:

• Learn Micro Focus™ Learn COBOL extension and Micro Focus™ COBOL Fundamentals Course
• Micro Focus Enterprise Extension for Visual Studio Code
• Micro Focus COBOL Extension for Visual Studio Code
• .NET Support
• Application Workflow Manager
• AppMaster Builder
• COBOL Language
• Compiler Directives
• Data Modernization Advice
• Debugging
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration (ESCWA)
• Enterprise Server Security
• HCO for PostgreSQL
• IMS support
• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• Micro Focus Unit Testing Framework
• OpenESQL
• PL/I Support
• Terminal Emulation
• Tracing

Learn Micro Focus™ COBOL Extension for Visual Studio
Code and Fundamentals Course

Back to Top
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Micro Focus has released a new video-based training course in COBOL, Fundamentals Course. The
course teaches the fundamentals of the COBOL language, introduces the syntax, and usage of Micro
Focus COBOL tools.

The course is ideal for developers familiar with C, Java, or .NET who want to learn COBOL. It doesn't
matter what language you know, as long as you have experience of standard programming concepts, this
course is for you.

A new Learn Micro Focus™ COBOL Extension for Visual Studio Code is available. The extension comes
with the training materials for the COBOL training course. For information about the COBOL course, and
the Learn Micro Focus™ COBOL Extension for Visual Studio Code, visit www.cobol.com.

Note: This extension is not included with the Enterprise Developer installer.

Micro Focus™ Enterprise Extension for Visual Studio
Code

Back to Top

The following features are now available in the Micro Focus™ Enterprise Extension for Visual Studio Code
when you use it with Enterprise Developer 9.0:

• A PL/I Language Server is available. This enables the following advanced features in the PL/I editor -
Find All References, Peek, Outline view, collapsible regions, Rename, Navigate To, background error
reporting, variable highlights.

• A new button, , Debug PL/I Program or Run PL/I Program in the top right corner of the editor, is
present for the current PL/I program.

• You can now specify the PL/I main file context for include files if an include copybooks is referenced in
more than one program.

Note:

• This extension is not included with the Enterprise Developer installer.
• This extensions also installs the Micro Focus™ COBOL Extension for Visual Studio Code.

Micro Focus™ COBOL Extension for Visual Studio Code
Back to Top

The following features are now available in the Micro Focus™ COBOL Extension for Visual Studio Code
when you use it with Enterprise Developer 9.0:

• JVM COBOL debugging
• COBOL notebooks where you can have text and executable blocks of COBOL code in the same file.
• Colorization for COBOL directives files, cobol.dir.
• A new button, , Debug COBOL Program or Run COBOL Program in the top right corner of the

editor, present for the current COBOL program.
• Configuration setting for custom tab stops.
• A Micro Focus COBOL terminal in the TERMINAL pane.
• You can now specify the COBOL main file context for copybooks if a copybooks is referenced in more

than one program.

Note: This extension is not included with the Enterprise Developer installer.
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.NET Support
Back to Top

This release provides the following enhancements to .NET support:

• This release installs several NuGet packages each of which contains the assemblies for a specific Micro
Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0 are linked to a
core package, MicroFocus.COBOL.Runtime.Core, that includes the basic functionality for the projects.
You need to add any additional packages (such as a specific file handler, COBOL Accept/Display etc.)
manually to the projects. The new packages enable better granularity of distributions, and provide more
flexibility and control over what is packaged with the application.

• New SDK version - the Micro Focus SDK version has changed to version 2.1. See Upgrading
existing .NET COBOL project files in your product Help for details on how to upgrade your existing
projects.

Application Workflow Manager
Back to Top

This release offers the following improvements:

• A new Git Function Package - provides tools that support common Git interactions such as Clone, Add,
and Commit. This function package provides tool types to integrate the distributed revision control
system Git into your AWM model and enabling you to build a development workflow that includes Git
version control actions within the AWM Team Developer perspective.

• The Micro Focus z/Server connection is now supported in Enterprise Developer (UNIX) in the Remote
Systems view. A Micro Focus z/Server connection provides access to an IBM z/OS system enabling you
to work on data sets of the MVS subsystem, manage job output from the JES subsystem, and work on
files of the USS file system.

AppMaster Builder
Back to Top

This release includes new functionality to support long and spacey paths. This affects the following:

• 8dot3 short-name creation behavior is no longer required on your computer file systems. See your
Windows documentation for more information about enabling and disabling 8dot3 short-name creation.

• AMB file-tailoring skeleton files no longer require modification (usually these modifications consisted of
enclosing paths within quotes) to use long and spacey file names.

• You must compare and reintegrate any customizations applied to file-tailoring skeleton files used in
earlier versions of AMB into the new skeleton files provided with this release. These files are found in
your %ProgramFiles(x86)%\Micro Focus\Enterprise Developer\etc\ispslib directory,
and include:

SSMSISP
SSMSDLG
SSMSMFS
SSMCHK
SSMPCOM
SSMSCGEN
SSMCOMP
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SSMOXGEN
SSMCBL
SSMMBMS
DVSQL2
DVSQLR
DVSYMS
DVSYMSX
DVBAT
DVVSM2
DVMAIN
DVJOBVSM
DVJOBDDG
DVJOBIMS
DVJOBSQL
DVCHECK
DVIMS2
DVCOPY

COBOL Language
Back to Top

This release provides the following new features and enhancements to the COBOL language:

• Double-colon, ::, qualification is now available as a qualifier for data names and when dereferencing
pointers.

• PERFORM frame local variables - variables that are DECLAREd are now properly scoped. Reentering
the SECTION, whether recursively or after leaving, gives a new instance of such variables. This
provides better locality of data, and helps with writing of better structured code.

• Parameterized sections - syntax that allows program sections to accept arguments and return values.

• PERFORM of a SECTION can now pass arguments to that SECTION.
• A result can be returned to the code that PERFORMed the SECTION.
• Sections that return a value can be used as functions, in contexts where an identifier is expected.

• Compiler can identify platform at compile time - the compile-time constants __unix, __windows,
__dotnet, __jvm, and __native have been introduced. These can be tested in $if statements to
tailor code to the platform being used.

• Enhanced CBL_STRING_CONVERT library routine - CBL_STRING_CONVERT can now convert
strings to and from Base64.

The following enhancements add further support for the IBM Enterprise COBOL version 6.4:

• User-defined functions - user-defined functions are now available in an Enterprise COBOL dialect for
version 6.4 compatibility. Reference the product Help, General Reference > COBOL Language
Reference > Part 3. Additional Topics > Additional Dialect Support > Enterprise COBOL Syntax Support
> User-Defined Functions under ENTCOBOL dialect. A new Compiler directive, MANAGED-FNC-
PARAM-BY, enables you to specify whether the managed behavior of numeric function parameters
should default to BY VALUE or BY REFERENCE.

• Enhanced mechanism for interoperation between Java and COBOL - The COBOL and Java
interoperability has been enhanced to extend the capabilities of your COBOL applications with Java. It
removes the need to write object-oriented (OO) COBOL, as your native COBOL and Java programs can
now interoperate in the following scenarios:

• COBOL programs can be marked as JAVA-CALLABLE, meaning that they can be called from Java
as though they were Java static methods.
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• COBOL program can call Java static methods using the java.class.method call.
• COBOL data can be shared with Java programs by marking it as JAVA-SHAREABLE.

• Comprehensive support for automatic conversion between a wide variety of popular Java data types
and their corresponding COBOL types so that parameter passing and returned value handling require
no special processing in user code.

Compiler Directives
Back to Top

This release provides the following enhancements.

A new mechanism for setting Compiler directives (Technology Preview):

• Common directives files - this release introduces common directives files, directives.mf files, that
enable you to automatically provide all required directives needed to compile multiple and Mainframe
Subsystem applications without having to specify the directives individually. This feature is not available
for Assembler or IMS.

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use
and it is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will
be delivered at a GA level and if it is, then the functionality provided might differ considerably from
this technology preview.

New Compiler directives:

• ALPHA-LIT-CONT - determines whether the right margin or the end-of-line is used to delimit the
continuation of a non-numeric literal.

• DECLARE - defines the behavior of locally declared variables.
• ILEXPOSEALPHA/ILEXPOSEGROUP - these two directives can expose alphanumeric or group items

passed by value to parameterized sections or methods in JVM COBOL programs as byte arrays (the
default is to expose as string objects).

• ILSTRINGLOAD - where JVM COBOL programs with a very large number of distinct alphanumeric
literals cause internal limits to be exceeded, use this directive to create these literals in a backing file,
which can then be converted to strings at run time.

• MANAGED-FNC-PARAM-BY - determines whether user-defined function parameters are passed BY
VALUE or BY REFERENCE by default when compiled with JVMGEN.

• INITIAL - determines how Working-Storage is initialized for programs marked as IS INITIAL.

A family of new Compiler directives has been introduced to support the new mechanism for interoperation
between Java and native COBOL:

• JAVA-SHAREABLE - use the JAVA-SHAREABLE ON and JAVA-SHAREABLE OFF directives to bracket
one or more WORKING-STORAGE data items to indicate that they are to be made read and write
accessible from Java applications interoperating with this COBOL program.

• JAVA-CALLABLE - instructs the Compiler to make the COBOL program automatically callable from
Java.

• JAVA-GEN-PROGS, JAVA-GEN-STRG, JAVA-OUTPUT-PATH, and JAVA-PACKAGE-NAME - control the
behavior of COBOL programs that interoperate with Java through the JAVA-CALLABLE or JAVA-
SHAREABLE directives or by calling Java static methods using the CALL statement.

Data Modernization Advice
Back to Top

The product Help now includes advice on moving your COBOL data files, such as flat files, VSAM, indexed
or sequential files, etc. to a relational database (RDBMS). The documentation lists the solutions included in
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Enterprise Developer that enable you to achieve this, including advice on the best option for your
application as well as performance considerations.

Debugging
Back to Top

This release provides the following new feature:

• In Eclipse, new Debug and Run configurations have been added for debugging and running COBOL/
Java Interoperability applications. These enable you to debug COBOL programs calling Java static
methods. To debug Java code calling a COBOL program, you must create a Java Application launch
configuration and manually define the VM arguments property -Djava.library.path with a value
representing the output path to the native library produced from the COBOL builder.

Eclipse
Back to Top

Enhancements are available in the following areas:

Eclipse IDE:

• Eclipse 4.24 (2022-06) support, which is shipped and installed with Enterprise Developer. Versions of
Eclipse prior to this one are not supported.

• Exporting code coverage results - an option has been added to the Code Coverage view to allow you
to export the current code coverage results to a .tcz file.

• The Problems view now displays a sequence number column.
• A new project template is available for COBOL/Java interoperability applications. The project enables

you to compile both COBOL and Java sources at the same time.

COBOL editor:

• Auto-indenting on end-*.
• Collapsible regions for EVALUATE statements, and for 01 group items - a new option, Enable folding

for group level items, has been added to the Eclipse preferences (Window > Preferences > Micro
Focus > COBOL > Editor > Folding).

• Local variables support.
• Parameterized sections - support is available in the editor for parameterized sections.
• Paste JSON as COBOL classes - you can now copy JSON data and do a Paste JSON As Classes into

a JVM COBOL file. This generates COBOL classes which enable you to deserialize the data in those
classes.

• A Quick Fix is available for end of scope termination. To enable this, your project must have the
NOIMPLICITSCOPE Compiler directive set, and error level to warning as errors.

• Renumber lines on save - line numbers can be automatically applied to a source file when it is saved,
by selecting Perform line numbering on save from Window > Preferences > Micro Focus > COBOL
> Editor > Line Numbering.

• Case preference for COBOL keywords on code clean up. A new preference in the code clean up profiles
enables you to convert all COBOL keywords to uppercase or lowercase, if required.

Enterprise Server
Back to Top

This release provides the following enhancements:

What's New | 11



• A new casverify command-line utility is available. This utility enables you to verify the configuration of
a specified enterprise server region without attempting to start it, and also enables you to create
immediate diagnostics information in JSON or human-readable output. Verification stages are modular,
enabling you to specify which validation checks to run.

• You can now list job steps to enable users to perform advanced restarts. Job steps can be output to
JSON by specifying casout /%jnumber or output to a table by specifying casout /%tnumber. See
casout for more information.

• Installation improvements on UNIX - when upgrading from releases 6.0, 7.0, or 8.0 on UNIX, Enterprise
Developer now preserves more configuration details. During the installation of the product, a set of
configuration files are moved to a config location before the upgrade occurs. These are linked back to
the product install location on completion. When you reinstall the full product, install a patch update, or
install an upgrade to the same location, the previous configurations settings are maintained.

Previously, the upgrade process required manual intervention to redeploy existing configuration settings.
This now occurs automatically.

• Enterprise Developer CICS now supports the MAPPINGDEV option of SEND MAP and RECEIVE MAP
commands.

• Application diagnostic reporting now enables you to collect JCL process failures. See Application
Diagnostic Reporting for Enterprise Server for more information.

Enterprise Server Common Web Administration (ESCWA)
Back to Top

Enhancements are available in the following areas:

• Accessibility improvements - provide improved compliance with 508 and WCAG 2.1 standards.
• API, version 2 extensions - includes updated versions of some of the existing API version 1 endpoints,

and has been extended to contain more endpoints.
• Merged Archived Spool - you can now configure an enterprise server region to view a merged archived

spool in the UI. You can view multiple archived spools from a single region, and view old spool
information for multiple jobs that have ran under a previous name

• Page search facility - you can now search for a page that contains a specified search string. This
enhancement is part of the WCAG 2.1 requirements for accessibility.

• PAC clients - the ESCWA UI lists all TN3270 clients connected to a PAC. This enables you to administer
and monitor clients across the entire PAC from a single PAC region.

• TLS-enabled Redis connections. ESCWA now supports administering and monitoring PACs with a TLS
Redis SOR.

Enterprise Server Security
Back to Top

This release provides the following new features and enhancements:

• Demo CA - the component has been completely redesigned and is now included as part of Enterprise
Developer. Demo CA supports multiple installations, uses up-to-date cryptographic support, and
generates modern version 3 certificates with SANS, PKIDs, AKIDs, etc. signed by an intermediate CA.
Demo CA is now easier to use and has improved interoperability with third-party SSL/TLS systems.

Note: Micro Focus strongly recommends that Demo CA is only used for SSL/TLS development
and testing and is not intended for use in a production environment.

• esfupdate support for the Vault Facility - the esfupdate utility now supports the use of the Vault
Facility for credentials it needs to connect to MFDS.

• OpenSSL 3.0 - OpenSSL has been updated to use the current Long Term Supported OpenSSL
cryptographic library.
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• VSAM External Security Manager (EAP) - the VSAM ESM Module is a new option for Enterprise Server
security which is simpler and more convenient than using LDAP-based security. The VSAM ESM
Module provides a security manager for Enterprise Server which keeps security data in COBOL data
(VSAM) files. It provides many of the features of the MLDAP ESM Module but does not require an LDAP
server or other third-party solution. Security data can be imported from a YAML file, facilitating the
securing of Enterprise Server and the modification of its security data.

Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require
further clarification.

HCO for SQL Server
Back to Top

This release includes support for the following:

• The Define Lists tool in the HCOSS UI has been enhanced to enable you to select a dependency mode
to use when creating a transfer list. The available modes are:

Default Automatically include all parent objects of the selected object.

Family tree Automatically include all parent objects of the selected table.

Automatically include the child objects of each parent object.

Repeat until no more parents and children are found.

No dependency handling Include the selected table only (do not include any parent or child objects).

• The Transfer Data Tool now includes the start and end date and time for each table transfer.

HCO for PostgreSQL
Back to Top

This release includes support for the following:

• PostgreSQL Global Development Group (GDG) community edition and Amazon AWS via new options
for the TARGETDB directive.

• Migration of z/OS DB2 COBOL programs to PostgreSQL GDG community edition.

Attention: Support for PostgreSQL Global Development Group (GDG) community edition is in Early
Adopter Program (EAP) release status. We intend to provide the finalized feature in a future release.
Please contact Micro Focus Customer Care if you require further clarification.

IMS Support
Back to Top

This release includes the following new features for IMS:

• A new environment variable, ES_IMS_DISPLAY_NEW, has been added to enable the new z/OS /
DISPLAY timestamp output format.

• APARM handling has been updated to use EBCDIC APARMs obtained from EBCDIC applications. In
addition, the APARM positional parameter for DLI has been changed from 19 to 20 to be consistent with
the IBM IMS documentation. The APARM positional parameter for BMP applications remains at 19. 

• The ES_IMS_APARM_DLI environment variable has been added to enable the APARM handing
behavior of previous releases. See ES_IMS_APARM_DLI for details. 
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Interface Mapping Toolkit
Back to Top

This release provides the following enhancements:

• YAML support is now available for COBOL client generation. OpenAPI schemas can now be in YAML, in
addition to JSON format.

• A new option, Refresh Service, has been added to the Web Services and Java Interfaces context
menus. Use the Refresh Service option to update the bitism of the program for an existing Web
Service or Java interface after changing the bitism of the Eclipse project or the COBOL program.

JCL Support
Back to Top

• In this release the security around running programs from JCL jobs has been enhanced to enable you
to limit:

• The location of the programs to load
• Permission to run particular programs based on user ID

This release writes several additional messages to the job log as a JCL job runs, including the location
from which each program is loaded. For example:

JCLCM0303I Program IDCAMS (MFJAMS) loaded from library
SYS1.LOADLIB

When running one of your own programs, you might see messages such as:

JCLCM0305I Failed to find program JCLREAD in private libraries
and SYS1.LNKLIB.
JCLCM0306I Number of SYS1.LNKLIB entries: 0.
JCLCM0303I Program JCLREAD loaded from library SYS2.LOADLIB.

Combined, these three messages indicate that the program was not found in the main program search
path (SYS1.LNKLIB) but has been loaded from the JES Program Path (SYS2.LOADLIB).

For more information about increased JCL security checks including a configuration example, see JCL
Enhanced Security Checks in your product Help. For information about suppressing security check
messages in the job log, see ES_JES_HIGHER_SECURITY_LEVEL, also in your product Help.

• The MF_SPLJNO_LOCK environment variable has been added. Using this variable, you can change
the process by which the JES engine accesses the job number of a JCL submission to enable
enqueuing, which can increase throughput, reduce latency, and reduce disk/file access. For details, see
MF_SPLJNO_LOCK. 

Mainframe Access
Back to Top

This release includes the following new features for:

• Mfdaemon vault usage - the Mfdaemon persistent stored secrets are now stored in the vault.
• TAUZCAPP master configuration file location from JCL - MFA Server now enables you to specify the

location for the master configuration file, required by TAUZCAPP, to be performed via JCL instead of
having to edit a REXX script.
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• UNIX support for WebAPI USS - the MFDAS command-line USS functionality is now supported on
UNIX.

Micro Focus Unit Testing Framework
Back to Top

The Micro Focus Unit Test Seam pre-processor (mfupp) has been enhanced to aid the creation of self-
contained unit tests that contain EXEC CICS or EXEC SQL statements. These EXEC statements can be
removed or mocked depending on the requirement of the test case.

The Micro Focus Unit Test Runner has also been enhanced to aid the development of these styles of unit
tests by the addition of new code generation arguments available from the command-line interface.

OpenESQL
Back to Top

In this release, OpenESQL applications now support z/OS DB2 syntax for the community version of
PostgreSQL provided by the Global Development Group (GDG).

PL/I
Back to Top

This release includes enhancements in the following areas:

Open PL/I Compiler:

The following enhancements make the migration of existing applications to new platforms easier. They also
provide an improved functionality when using Open PL/I to develop z/OS applications.

• The QUICKSORT and QUICKSORTX built-in functions are now supported.
• Restricted expression evaluation now also takes place on AUTOMATIC, DEFINED, and BASED

declarations in addition to STATIC which was added previously.
• Support is available for the XMLCONTENT attribute.
• The use of the RELEASE statement now implies OPTIONS(FETCHABLE).
• Improvements have been made to the support for factored lists used in the INIT attribute of a variable

declaration.
• DEFAULT RANGE(*) with no attributes no longer causes the compiler to abort.
• Support is available for the FIXEDOVERFLOW condition.
• Support is available for the FOFLONASGN, FOFLONDIV, FOFLONMULT, FORCEODD Fixed Decimal

behaviors.
• Support is available for validation of FIXED DECIMAL data.

• Support has been added for more than 2GB of static data in a single procedure.
• Support has been added for placing uninitialized static data in the .BSS section.
• Improved diagnostics when passing an array to a procedure which expects an array with differing

attributes.
• Improved diagnostics when passing CONTROLLED variables as parameters and attributes are in

conflict.
• PL/I FETCH xxxx SET() syntax supports setting a PL/I ENTRY LIMITED.

Open PL/I Debugger:
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• Performance improvements on the display of arrays and complex structures.
• Support for arrays declared with negative array bounds.
• Improved debugger performance when watchpoints are set but not active.
• Improved breakpoint clean-up and handling in-between debugger sessions under Enterprise Server.
• Added a message to PLIDUMP to print {cond static external} for CONDITION declarations in the locals

section rather than printing a generic "variable not found" message.
• Added support for decorated symbol/variable names in PLIDUMP on Windows.
• New watch points are now honored after a CONVERSION condition was raised.
• Remote debugging is supported on Solaris (SPARC).

Open PL/I EXEC Preprocessor:

• It is now possible to specify DB2 LUW OPT guidelines within static SQL.
• The stability of CICS API calls on 64 Bit Solaris (SPARC) has been improved.

Open PL/I Macro Preprocessor:

• The COMMENT built-in function now supports comments larger than 100 bytes in length.
• The -tagmin preprocessor option supports skipping of %SDEBUG; and %RDEBUG; statements when

the replacement text fits on the same line as the macro invocation without wrapping.
• The conditional statements processing has been improved.

Open PL/I Language

Note: These features are in Early Adopter Program (EAP) release status. We intend to provide the
finalized features in a future release. Please contact Micro Focus Customer Care if you require further
clarification.

• Open PL/I now supports ordinals via the DEFINE ORDINAL statement, the ORDINAL attribute for the
DECLARE statement, and the ORDINALNAME, ORDINALPRED, and ORDINALSUCC built-in
functions.

• The DO statement now supports UPTHRU and DOWNTHRU.

Open PL/I Run-Time System:

The following enhancements are available:

• Support for more than 2GB of static data in a single procedure.
• Support for placing uninitialized static data in the .BSS section.
• JSONPUTMEMBER now supports quotation marks within its input.
• Support for the XMLCONTENT attribute.
• The PL/I Run-Time System optionally provides the ability for ERROR to be driven in place of

STRINGRANGE and SUBSCRIPTRANGE.
• PLIDUMP display of the offset within prologue code a signal is received within the prologue of a PL/I

procedure.
• Support for FIXEDOVERFLOW condition.
• Support for FOFLONASGN, FOFLONDIV, FOFLONMULT, FORCEODD Fixed Decimal Behaviors.
• Support for validation of FIXED DECIMAL data.
• The speed for FIXED DECIMAL operations has been improved.
• The stability of CICS API calls on 64 Bit Solaris (SPARC) has been improved.

Product Help:

• The product Help includes a new section on Open PL/I Conditions.
• A new section, Open PL/I Problem Determination is available. Reference this section to learn how to

mitigate execution, link, and debugger problems, how to use PLIDUMP to resolve issues, and also to
learn about specific PL/I-related information pertaining to the use of the Consolidated Tracing Facility.
This new documentation also includes a list of data items you need to collect before raising a PL/I
problem with Micro Focus Customer Care.

16 | What's New



Terminal Emulation
Back to Top

This release provides the following new features.

• Enterprise Developer and Enterprise Server now incorporate Host Access for the Cloud (HACloud) to
provide 3270 emulation. HACloud is the leading Web-based emulator and requires no additional
desktop installation. HACloud replaces the Rumba+ Desktop emulator previously supplied with
Enterprise Developer. Customers that have Rumba+ Desktop entitlement can continue to use it within
Rumba+ Desktop.

• In this release, Host Access for the Cloud supports session configuration options, as well as creating
and using macros.

• IDE support for Micro Focus Reflection Desktop - you can now select Reflection Desktop as the default
TN3270 display to open from the IDE when you run or debug your TN3270 applications. You can now
play Reflection or Rumba+ Desktop macros with Reflection Desktop.

Tracing
Back to Top

This release provides the following enhancements and new features:

• Improvements have been made to the to the Common Communications Interface (CCI) tracing. CCI
tracing can now be enabled using only the Consolidated Trace Facility (CTF) configuration, without
needing to set trace options in CCI.INI or the environment as well. SSL/TLS trace points have been
added to the CCI CTF trace, making it easier to control. It uses the same mechanism as other
components such as the COBOL RTS. SSL/TLS tracing is now incorporated into CTF, placing all
communications trace output in one place and adding timestamps and other useful information to these
tracepoints. See Enabling CCI Tracing for more information.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• .NET Support
• Application Workflow Manager
• AppMaster Builder
• Compiler
• Data Tools
• Documentation
• Eclipse IDE
• Enterprise Server
• File Handling
• HA Cloud
• IMS Support
• JCL Support
• Micro Focus Directory Server
• PL/I Support
• Runtime System
• Setup Issues (Windows)

.NET Support

Back to the list

• The 9.0 release installs several .NET 6 NuGet packages each of which contains the assemblies for a
specific Micro Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0
are linked to a core package, MicroFocus.COBOL.Runtime.Core, that includes the basic
functionality for the projects. You need to add any additional packages (such as a specific file handler,
COBOL Accept/Display etc.) manually to the projects.

Building existing .NET COBOL projects created prior to 9.0 might result in build errors. You can ensure
compatibility by enabling the use of the MicroFocus.COBOL.Runtime metapackage. Alternatively,
you need to add any required NuGet packages manually to the older projects.

See Upgrading existing .NET COBOL project files in the product Help for details on how to upgrade.

Application Workflow Manager

Back to the list

• The related AWM resource (required to perform the resource operation) of the open file is now cached.

02307586 (278005)

AppMaster Builder

Back to the list

• In this release, AMB file-tailoring skeleton files no longer require modification (usually these
modifications consisted of enclosing paths within quotes) to use long and spacey file names. If you use
customized file-tailoring skeleton files, you must compare and reintegrate any customizations applied to
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these files into the new skeleton files provided with this release. File-tailoring skeleton files are found in
your %ProgramFiles(x86)%\Micro Focus\Enterprise Developer\etc\ispslib directory,
and include:

SSMSISP
SSMSDLG
SSMSMFS
SSMCHK
SSMPCOM
SSMSCGEN
SSMCOMP
SSMOXGEN
SSMCBL
SSMMBMS
DVSQL2
DVSQLR
DVSYMS
DVSYMSX
DVBAT
DVVSM2
DVMAIN
DVJOBVSM
DVJOBDDG
DVJOBIMS
DVJOBSQL
DVCHECK
DVIMS2
DVCOPY

Compiler

Back to the list

• Preprocessor options of more than 256 bytes are now supported, and no longer cause the Compiler to
crash.

02289875 02308713 (272069)

Data Tools

Back to the list

• A new print function available from the File group and the File menu enables you to print the records
shown in the editor.

00367084 (12432)
• An enhancement to the Compare Files function has been added, so that when a comparison is made,

the File Information option shows a statistics overview of the comparison being displayed.

02200177 (222157)
• In the Data File Editor, the Compare Files function has been enhanced to allow you to select start and

end columns in which to compare, so only a subset of a record is compared, rather than the entire
record.

02306654 (222159)
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• A Quick final page access option has been added to the Preferences dialog box of the Data File
Editor. When selected, large variable sequential files (files > 10,000 records) immediately jump to the
last page of the file when it is opened.

02330923 02365033 02399254 (294002)

Documentation

Back to the list

• When using the cob command to link PL/I programs targeting Enterprise Server, you must include the -
lmfpdfpz parameter in your link command to avoid problems in multi-step jobs. 

02451241 (386064)
• FIXEDOVERFLOW conditions are now implemented and will occur when detected.

02163371 (203207)

Eclipse IDE

Back to the list

• When creating a new remote project using the SSH file system, the wizard now allows you to create a
new Micro Focus DevHub using SSH connection. (Previously, only the Micro Focus DevHub SSH
Only connection was available.)

(301058)
• The Import Server option (from within Server Explorer) is now working correctly with an XML if the

XML file type is known. If the XML file is in an unknown format, an error message is displayed, and
import is not possible.

02345573 (310017)

Enterprise Server

Back to the list

• A new option to uninstall a PAC installed on an enterprise server region before deleting the region has
been added to ensure that all PAC components are properly removed.

01907370 (124107)
• ESCWA now validates the TLS properties to help prevent errors on entry.

Note: If ESCWA has an invalid TLS configuration, it reverts to starting without TLS enabled.

01983736 (203178)
• In ESCWA, a Stop for IMS MPRs, JES Initiators, and JES Printers now operates correctly.

02311796 (286178)
• An issue with not being able to update or navigate the ESCWA UO though the job output in the spool

while it is still running has been resolved.

02322494 (286142)
• In ESCWA, the default dashboard can now be modified for all users of a server.

02458710 (392040)
• In ESCWA, the FCT Fix Up button has been added to the Active FCT page. See Active FCT in your

product Help for more information.

(374021)
• The Job View page in ESCWA now includes a list of job steps that have run during the current

enterprise server region up time.

(347033)
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• A new configuration property has been added to ESCWA to enable the default language the UI displays
to be overridden from the user's browser locale.

02227239 02307446 (260128)
• ESCWA now supports TLS enabled Redis repositories.

(306097)
• In ESCWA, the Process ID column has been added to the table on the Dynamic Debug page. See

Dynamic Debug in your product Help for more information.

(350029)
• In ESCWA, the Spool page can now display multiple Spool Output types.

02503214 (401184)
• ESCWA now supports Expiration Dates for Catalog DCB.

02159515 (202201)
• In ESCWA, a new PAC Client List page has been added. This page displays a list of PAC members

and associated information. See PAC Client List in your product Help for more information.

(384037)
• ESCWA now supports merged archive spool. See Spool in your product Help for more information.

(245050)
• An alternate index has been added to the non-recoverable temporary storage file TXTSNR. This is to

enable queues to be returned in alphabetical order when browsing with INQUIRE. When warm starting
non-recoverable TS, if TXTSNR has only a single key then the file will automatically be upgraded to
include the alternate index. If there is a problem during the upgrade process then message CASI1405S
will be written to the console indicating the failure and that the enterprise server region will fail to start.
In this case, the file will either need to be repaired or temporary storage will need to be cold started.

Note: Once TXTSNR has been upgraded it can no longer be used on an older version of the
product that does not contain this fix.

02441509 (389045)
• Corrected the spelling for the db_server_name Configuration Manager property. You will need to

update existing 8.0 enterprise server region configurations by either applying any change on the
ESCWA General >Advanced page, or by updating the mfConfigManagerData MFDS property
through the ESCWA API. If this is not performed, the warning message CASCF0071W
Configuration Manager - The requested property (db_sever_name) was not found
will be displayed in the Console log during region initialization. This will not cause any issues if the
Region Database Server Name property was not previously used, or if it was set though the
ES_DB_SERVER environment variable. Otherwise, you will need to reset this property using the above
methods as the previous configuration for Region Database Server Name will not be honored, which
might result in the region failing initialization.

(350050)
• A recent change resulted in EXEC CICS TIME(...) expiring immediately. This has been fixed.

02525957 (411120)
• In the context of a multi-hop Distributed Program Linking (DPL), if the last stage used the default mirror

transaction, its back-end could be left hanging if a SYNCPOINT was invoked by the upstream partner.
This has been fixed.

02432614 02434318 (377071)
• You can now list job steps to enable users to perform advanced restarts. Job steps can be outputted to

JSON by casout /%jnumber. Job steps can be output to a table by casout /%tnumber. See
casout in your product Help for more information.

(401023)
• When submitting JCL by content via ESCWA or the JCL command cassub, Enterprise Server will now

authorize the request against a new cassub.content resource class under OPERCMDS. If this class is

Significant Changes in Behavior or Usage | 21



not specified then Enterprise Server will revert to existing behavior. See Resource Classes for ESMAC
and Operator Command Security in your product Help for more information.A prototype definition has
been provided in the standard LDIF files shipped with the product.

(313048)
• A new parameter, -i has been added to the cassub utility. This parameter enables the user to specify a

correlator up to 32-bytes long comprised of ASCII printable characters. The JCL engine will ensure this
correlator has not previously been supplied for a JCL JOB. If a duplicate correlator is detected, the job
submission will be rejected and the previous JOB ID will be returned. See cassub in your product Help
for more information.

02462072 (394004)
• The Redis server supplied with the product is now version 6.2.6.In ESCWA, you must now specify the

Certificate Authority Filepath, Certificate Filepath, and Private Key Filepath properties on the
Advanced Region Properties page for all enterprise server regions that are members of a PAC that
has a TLS-enabled Redis Scale-Out Repository (SOR). See Scale-Out Repositories in your product
Help for more information.

00373756 (12618)
• When a CICS abend occurs, the 4 letter abend code now appears after the Transaction ID in HSF

records. There has been no change in behavior in the case of an RTS abend, where the transaction
name followed by ABEND still appears.

(246037)
• EXEC CICS INQUIRE TASK LIST now includes dispatchable (queued) tasks in the returned LISTSIZE

parameter.

(365089)
• When performing a DPL targeting a program that had an installed PPT specifying that it was remote,

the use of the TRANSID option on the LINK would be ignored. This has been fixed.

02434323 (386136)
• During XA recovery, if a resource manager reports an in doubt transaction which has no log entry, a

CASXO0040W message will now be displayed in the console.

(425081)
• If a SOR cannot be connected during enterprise server region start up, then the region no longer starts.

Previously, this only applied to the PSOR, but now applies to other SORs which were only used for TS
and TD queues. This change was made because the previous behavior could lead to queues being
written to different locations (SORs or disk) across the PAC. If a PSOR cannot be connected during a
process start up when the region is already running, then the process will be blocked until the
connection can be established. Retries will be attempted at increasingly longer intervals. If a (non-
PSOR) SOR cannot be connected to at process start up when the enterprise server region is already
running, then the process will continue to start up. At queue access time, for a queue that must go to
that SOR, the connection will be retried. If this is unsuccessful then the command will receive an
IOERR.

02399193 (356005)
• ESMAC is disabled by default. ESMAC can be enabled from the Advanced Region Properties page in

ESCWA.

(397027)

File Handling

Back to the list

• The SQL Server ENQ/DEQ implementation has been modified to eliminate any possibility of ENQ
request failures occurring due to an intermittent Service Broker problem. The new implementation
introduces a new ENQ stored procedure, and modification of the existing DEQ one to allow it to work
with both the Service Broker and non-Service Broker implementations.
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(285197)
• The OPEN EXTEND operation now follows the behavior expected from the OPEN statement as

documented.

02454638 (386087)
• ICETOOL emulation now supports the RESIZE operator.

(350035)

HA Cloud

Back to the list

• The default color scheme for HA Cloud in Enterprise Server has been updated to cyan on black.

(291041)
• The bundled Host Access for the Cloud (HACloud) Session Server has been updated to 2.7.0.6.

(375012)
• Micro Focus Host Access for the Cloud shipped with Enterprise Developer now offers session

customization options such as connection, and display options, and the functionality to record, and run
macros.

(392026)

IMS Support

Back to the list

• A problem that occurred when a restart call (XRST) referencing a checkpoint ID received checkpoint
data that originated from a different program when a shared checkpoint log file was used and the other
program issued the same checkpoint ID has been fixed.  IMS now requires that the name of the
program issuing the XRST must match the name of the program that issued the checkpoint.

(310065)
• The JES alias feature is now supported for IMS application main programs executed from JCL.

02356855 (308032)

JCL Support

Back to the list

• After the release of Enterprise Developer 7.0 PU17 and 8.0, the structure of the M_SPL_JOB.dat file
was updated. If you are upgrading to this release from a release that does not contain the update, you
must rebuild M_SPL_JOB.dat using the following command, and then replace M_SPLJOB.dat with
NEW_M_SPLJOB.dat before executing the merge spool job.rebuild
M_SPLJOB.dat,NEW_M_SPLJOB.dat /r:v344-604

02516141 (407126)
• When performing an IDCAMS REPRO on a cluster with the LIKE parameter set, if the LIKE cluster has

data or index references associated with it, then similar data and index references are now created for
the new cluster.

02358077 (363063)
• If an XA switch module failed while a DSNRLI program was using it then there was no way to

programmatically restart the switch module. This has been corrected. If a module fails with an TX_FAIL
error code (-7) the module can be reassociated with the unit of work by calling DSNRLI IDENTIFY. In
this case the check for the correct DSNRLI call ordering has been suspended so that IDENTIFY can be
called after an TX_FAIL error. The TX_FAIL return code will be passed back to the calling program so
that it is aware of the error. TX_FAIL is -7 and will replace the normal DSNRLI return code (8).

02364792 (323018)
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• System symbols, defined in SYS1.PARMLIB(IEASYM00) can now be filtered by use of the LPARNAME
entry. See INITSYS.JCL in the jcl-symbols examples.

(387029)
• Security for loading utility programs, either supplied by the user or any Micro Focus utilities, has been

increased. Users can now specify a number of libraries that hold program modules and who can use
them. See JCL Enhanced Security Checks in the product Help for more information.

PSEC:103014 (86177)
• When a dataset is required by MFFTP to be sent (put) or received (get), then MFFTP issues a dataset

lock that remains in effect until the end of the step. The location of the physical files used by MFFTP are
also validated against the PHYSFILE rules (if implemented). This access validation could cause security
errors if access is not allowed to the location of the FTP input and output file and might require that the
location be changed. This is usually the default allocation location, but may also be specified by
MFFTP_TEMP_DIR, or by adjusting the PHYSFILE rules to accommodate the location.

02210700 (244030)
• A step running IKJEFT01 was incorrectly returning the highest return code of all commands executed

instead of the return code of the last command executed. The MF_IKJEFT_KEEP_MAX has been
added to correct this problem. Its default setting is MF_IKJEFT_KEEP_MAX=N. However, if the new
behavior leads to a change in the COND CODE, and this is a problem for your application, you can
return to the original behavior by setting MF_IKJEFT_KEEP_MAX=Y.

02532126 (415094)
• When the return code from an IKJEFT step exceeded 4095 it could be incorrectly adjusted depending

on the IKJEFT program called. To remedy this, the return code when IKJEFT01 is called is changed to
12. Also, when IKJEFT1A or 1B is called, the return code is adjusted to RC modulo 4096.

02514544 (406145)
• DSNRLI return codes did not always correctly reflect the outcome of the SRRCMIT and SRRBACK

functions. This has been fixed.

(408001)
• When the result of a SRRCMIT or SRRBACK call was a MIXED status, meaning that some XA modules

committed or rolled back and some did not, then DSNRLI issue either commit or rollback upon
shutdown at the end of the step. This was incorrect. DSNRLI will not NOT issue commit or rollback at
step end. The XA Recovery processing maybe able to recover the 'in doubt' transaction.

02512717 (406089)
• MFFTP has been enhanced to pass relevant file transfer information for FTP operations such as PUT,

GET, and DEL, to a user exit defined by the new environment variable, MFFTPXIT. To enable the exit,
set MFFTPXIT to a user-exit program file, for example, the provided MFFTPXIT.cbl sample file. A list
of valid parameters is in the provided mfftpxit.cpy copybook. When the user exit is enabled and an
FTP step returns a non-zero code, a copy of the *.op FTP output file is created using the *.out
extension in either the defined MFALLOC_LOC or MFFTP_TEMP_DIR location. Use the *.out file to
determine the cause of FTP operation failures.

02287628 (259117)

Micro Focus Directory Server

Back to the list

• The External Security Manager (ESM) checks did not occur when an enterprise server region started or
stopped. This has been fixed.

02402188 (355001)
• To query Enterprise Server security configuration information (details of configured external Security

Managers and so forth) from the Micro Focus Directory Server when access is restricted, the authorized
Enterprise Server user must have at least Read permission for the Enterprise Server Administration
resource class User Administration entity.
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(285199)
• Micro Focus Directory Server now restricts access to enterprise server regions that a signed-on user is

not authorized to view.

02305916 (285169)
• Four new MFDS-only audit event codes (2 300, 2 301, 2 302, and 2 303) have been added. See Audit

Event Codes in your product Help for more information.

02412285 (365149)

PL/I Support

Back to the list

• When assigning a PICTURED item into a FIXED DECIMAL, FIXEDOVERFLOW is now triggered if
enabled and the target source or precision is not large enough to fit the PICTURED representation.

(400099)
• The Open PL/I compiler erroneously allowed OFFSETVALUE(POINTER)), namely

offsetvalue(sysnull()). The correct usage is: offsetvalue(binarvalue(sysnull())).

(386070)
• The internal consistency error in the PUT EDIT statement with a DO-loop that was never iterated has

been fixed; however, we recommend avoiding dead DO-loops in PUT EDIT statements as they result in
redundant code.

02518315 (407194)
• The Open-PLI compiler now performs Restricted Expression Evaluation on  AUTOMATIC, DEFINED,

and BASED declarations in addition to STATIC declarations as in previous releases.

00368483 (11358)
• The OPTIONS and LIMITED attributes now imply type ENTRY to correct a problem wherein type was

not specified and the default type was set by applying the I-N rule to the variable name.

02048549 (165087)
• The behavior of the PRECISION built-in was incorrect for most data types, except FIXED BIN, FIXED

DECIMAL, and PICTURE. This has been corrected.

(363237)
• When passing an array argument to a procedure with differing array dimensions or extents of the

corresponding parameter descriptor, a dummy argument was created. To correct this, a Severe
diagnostic message is now generated instead. In addition, when an array argument with variable
extents was passed to a procedure whose corresponding parameter descriptor had constant extents, a
dummy argument was created. To correct this, the array argument is now passed by reference and a
Warning diagnostic is generated. Both of these issues apply to passing arrays without surrounding
parentheses.  

02310772 (286006)
• Previously OPTIONS(FETCHABLE) was not implied by the coding of a RELEASE statement for an

ENTRY. This has been fixed.

01862366 (120035)
• Data exception 8097 now occurs when the sign nibble of a fixed decimal value does not contain a valid

sign 0x0A thru 0x0F during an arithmetic operation, conversion, or assignment.

02198788 (222107)

Run-Time System

Back to the list

• By default, CTF information no longer appears in AUX Trace of an enterprise server region. To enable it,
you now need to set mftrace.emitter.es#level in the MFTRACE_CONFIG.

Significant Changes in Behavior or Usage | 25



(328008)
• If an error occurs during thread clean-up, the runtime will now attempt thread clean-up again. If it fails

for a second time the runtime will call _exit() to terminate the process immediately.

02286519 (258130)
• On UNIX platforms, when linking using the cob command in place of ldpli, you must include all of the

specified ldpli -l options on the cob command line. 

(410018)
• Attempting to call COBOL functionality after calling the cobtidy() API, to de-initialise the COBOL

RTS, will now result in a COBRT090 error message.  Previously it was documented that the results
were undefined and it could cause subsequent problems, and/or errors, especially in a threaded
environment.  The aim of this change is to give a more meaningful error message, earlier, to help
diagnose such issues.

(301136)
• The limit for the MAXGENERATION emitter property (for both BINFILE and TEXTFILE) has been

increased from 10 to 100. The file size limit for each of these generations, as set by the MAXFILESIZE
property, is 1000000KB.

02405466 (359001)

Setup Issues (Windows)

Back to the list

• Micro Focus Host Access for the Cloud emulator replaces the Micro Focus Rumba+ Desktop emulator
previously supplied with the installer for Enterprise Developer for Eclipse or Visual Studio. Customers
that have Rumba+ Desktop entitlement can continue to use it within Rumba+ Desktop.

(335003)
• In Windows 11 it is now possible to open COBOL 32-bit and 64-bit command prompts from the Terminal

application.

(421016)
• On Windows, you must uninstall earlier versions of this product before installing 9.0.

(380028)
• 32-bit Windows is no longer supported.

(382034)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• The Server Core form of Windows Server 2019 is not supported.

• In Enterprise Developer 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur
with running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Enterprise Developer 3.0 or earlier, then executed in
Enterprise Developer 4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Enterprise Developer 6.0 and later, the .NET COBOL and JVM COBOL
run-times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a
version 5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue,
you need to recompile any programs that use this construct in the newer versions of Enterprise
Developer.

Program that do not use NATIONAL data, or those that have been recompiled in Enterprise Developer
6.0 or later are not affected.

• The ChangeMan Attachment models of release 5.0 and earlier are not working in the expected manner
under Enterprise Developer 8.0 or later. This is a result of several tools that are called with a static
value=`*` in the input parameter CMG_PROP_STATIC_SUBSYSTEM. If you want to run a ChangeMan
attachment model 5.0 and earlier under Enterprise Developer 9.0 you must remove the static value=`*`
from all CMG_PROP_STATIC_SUBSYSTEM input parameters.

• On the Solaris platform, Enterprise Server Common Web Administration (ESCWA) cannot enable the
External Security Facility (ESF). This results in ESCWA failing to enable user authentication and
authorization. However, you can still enable authentication and authorization for the Micro Focus
Directory Server (MFDS) and corresponding enterprise server regions.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• Application Workflow Manager
• AppMaster Builder
• CICS Support
• COBOL Language Server
• Code Analysis
• Codeset Support
• Common Communications Interface
• Communications Server
• Compiler
• Containers
• Data Tools
• Debugger
• Dialog System
• Documentation
• Eclipse IDE
• Enterprise Server
• File Handling
• HA Cloud Support
• IBM Language Environment for OS/390 & VM Support
• IMS Support
• JCL Support
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• Micro Focus Common Client
• Micro Focus Cryptographic Library
• Micro Focus Directory Server
• Micro Focus License Administration
• PL/I Support
• REXX Support
• Run-time System
• Setup Issues (UNIX)
• SQL: COBSQL
• SQL: HCO for DB2 LUW
• SQL: HCO for SQL Server
• SQL: HCO for PostgreSQL
• SQL: MBDT Utilities
• SQL: OpenESQL
• SQL Option for DB2
• XML Support

Application Workflow Manager

Back to the list
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• Text area dialog fields are now checked after the dialog OK button is clicked. An error message appears
in the dialog description area if the max line or chars per line is exceeded.

02472205 (394108)
• In the default MVS file mapping, the local code page value for the data set template *.AWMMODEL* is

set to UTF-8. As the default file mapping is only effective for a new workspace, Micro Focus
recommends that you change the local code page value in the file mapping for *.AWMMODEL* from
DEFAULT to UTF-8 in existing workspaces manually.

(380032)
• Local file copying from the MVS Explorer are now encoded and saved with the connection local code

page.

02070256 (207007)
• Else (If) action descriptor statements did not always work as expected when multiple If statements were

specified. This has been fixed.

02287350 (259118)
• If a property of type SelectValue with unspecified Label Keys was used as a non-editable modeled

dialog field, this resulted in an exception. This has been fixed.

02345550 (297117)
• The new attribute Local File Encoding has been added to the Operation System function package.

See Attributes for the Operating System Function Package in your product Help for more information.

(204054)
• Calling z/OS functions (Submit JCL to z/OS) before establishing a connection can now be executed

without error.

02258259 (256018)
• Using the Eclipse function package AWM tool Create Resource to update the location of linked folders

sometimes resulted in their being removed from the project dependency paths. This has been fixed.

02340680 (296046)
• z/OS data sets with volume serial ARCHIVE were not detected as migrated. This is now fixed.

02532719 (443003)
• AWM Modeling Support 8.0 was tested against IBM IDz v16.0 based on Eclipse 4.23. It can be used

with an IBM z/OS connection. There is a known issue using AWM Modeling Support 8.0 in IBM IDz 16.0
together with a MFA z/Server connection when trying to connect. Using an MFA z/Server connection is
not possible with Modeling Support 8.0 under IBM IDz 16.0.

02486829 (400021)
• Empty string values in the deprecated Affected Resource Name attribute sometimes resulted in

unexpected behavior when executing modeled actions. This has been fixed.

02367680 (314010)
• Parallel evaluation of modeled enabled conditions (for example, in modeless action descriptors) could

lead to unexpected behavior. This is now fixed.

02406754 (364046)
• The AWM master configuration now enables you to specify a URL as the platform under the keyword

Conf which points to an AWM model accessible via an http(s) link.

01825646 (123020)

AppMaster Builder

Back to the list

• During a Data View Import, Appmaster Buiilder looks for a fully qualified SQLDDL file if one is
referenced in the DDISYMB being imported. When this SQLDDL file cannot be accessed and its path
differs from the AppMaster Builder project path, the import process logic now looks in the project/group
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SQLDDL (or SQLSCHEM) and issues a warning if the referenced SQLDDL is instead found in the
project/group. An error is issued if the SQLDDL file cannot be found in either the project/group location
or in the referenced path in the DDISYMB file. 

(323020)
• An enhancement was made to save the value of the AutoLoad button on the SQL Subschema

Maintenance dialog box. Now, upon reentry of the dialog box, the previous selection state of the button
is retained.

02491027 (399078)
• You can now optionally display and select system tables from the DB2 catalog during Data View

creation and generation by checking a new box on the DB2 Catalog dialog box.

02457529 (395089)
• When importing a Data View containing SQL objects, table creator names with more than six characters

were truncated. This has been corrected to support eight characters for table creator names.

02512341 (409095)
• A problem that prevented the Linkage Section line from being generated when an APSPROG file ended

with a comment statement and also included an LK keyword entry has been fixed.

02558057 (439079)
• When adding PSB or DBD files to an AMB Data View, only files with no file extension displayed on the

Add Dialog selection list. This has been corrected such that files with .PSB and .DBD extensions also
display.

02529410 (414026)
•  When importing an IMS Data View that contained an IOPCB but did not reference any DBDs, the

PSBSRC file was excluded from the Data View sources. This has been corrected.

02529402 (415028)

CICS Support

Back to the list

• A problem with generating a COBOL copybook in the correct location and/or with the correct filename
when the BMS mapset did not define the LANG parameter has been fixed.

(380001)

COBOL Language Server

Back to the list

• Some performance issues when requesting workspace symbols in large workspaces have been
resolved. The operation is now limited to files that are open or parsed.

02384141 (338011)

Code Analysis

Back to the list

• MFDASMX no longer crashes when download process is initiated.

02411250 02427959 (363118)

Codeset Support

Back to the list

• The DISJOINING clause now works as expected when a DBCS hyphen is specified as part of the prefix
or suffix.
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(296145)

Common Communications Interface

Back to the list

• A handle leak on failed ISC connection attempts has been fixed.

02413198 (381021)
• TLS connections failed when a trust anchor was not specified. This has been fixed.

02534509 (446004)

Communications Server

Back to the list

• The MFCS resource leaked under certain circumstances. This has been fixed.

02257630 02405587 (254003)
• If an Enterprise Server listener was disabled at region startup, an attempt to start it while the region was

running would fail, possibly generating an exception or signal logged by the MFCS process. This has
been fixed.

(401103)
• Enterprise Server now supports stopping and restarting a stopped listener even when conversations

using that listener are still open. In previous releases, a listener could be stopped while there were open
conversations, but not restarted until those conversations ended; this restriction has been removed.

Note: Open conversations continue to be usable.

(244018)
• ESCWA can now display the enterprise server region console.log file if its location has been

changed from the instance system directory to another location.

01970295 (313012)
• An issue with the Micro Focus Communications Server failing when restarted automatically has been

fixed.

(313031)
• An issue that caused a connection authorization failure for TN3270 clients that use ELF or DCAS to

connect to Enterprise Server has been fixed.

(260042)
• An issue with using the Enterprise Server DCAS facility with TN3270 in "internal" mode on Linux and

UNIX has been fixed.

02429147 02433532 (375009)
• In Enterprise Server, the Communications Server process (mfcs) now logs the correct messages when

an HTTP conversation is terminated prematurely by the client.

02212920 (258094)
• Enterprise Server's handling of conversations aborted by the client or as the result of a network issue

has been improved, including fixes to resource leaks and error reporting.

(364115)
• The mfdepinst command now uses the MFDS credentials supplied in the configuration file or on the

command line for all requests to MFDS. This corrects a usability issue with installing COBOL Web
services or EJBs under Enterprise Server when the directory server is secured.

02373698 (254038)
• An issue with the Web Services and J2EE connector that caused chunked HTTP requests to be

improperly processed has been fixed.
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02378445 (321037)
• The DCAS feature of Enterprise Server has been enhanced to support extracting the Enterprise Server

user ID from the CN (Common Name) of the Subject name of the client certificate. This can be useful if
you have many client certificates to provision. See DCAS Security and DCAS conversation type in your
product Help for more information.

02442474 (384003)
• Enterprise Server's ability to detect conversations closed by the client or by errors such as network

failures has been improved. These conversation failures are now detected sooner, releasing
communications-related resources and providing better error reporting. See [idle check] Section in your
product Help for more information.

02412841 (365106)
• A new option has been added to the mfdepinst utility, --replace, removes existing package and

service definitions for the same namespace before installing the services defined by the CAR file. See
mfdepinst command in your product Help for more information.

(363026)

Compiler

Back to the list

• An 013-R error generated on compilation has been fixed.

02501331 (401125)
• JVM COBOL only. Some large and complex programs that used the DECLARE syntax gave a Run-

Time System error of the form:    java.lang.VerifyError: Local variable table overflowThese programs
now give a Compiler error of:    15-S Procedure division too large  

02379096 (335018)
• Within Eclipse, a program with an empty PROGRAM-ID in a JVM COBOL project no longer causes the

IDE to close.

(445004)
• A new directive, ILSTRINGLOAD, is now available for JVM COBOL programs, which can help in

situations where a program with a very large number of distinct alphanumeric literals causes internal
limits to be exceeded in a class (and at which point, an error is generated). Use the directive to create
these literals in a backing file, which can then be converted to strings at run time.

02170649 (380058)
• A program containing a debug line as its first line of source now compiles with an expected syntax error,

rather than a Compiler crash.

(306070)
• Querying the subordinate items of a group defined in a DECLARE statement now works as expected.

(414100)
• Debugging of a program with a copybook located via COBCPY, where the value of COBCPY is

extremely long, now works as expected.

02298722 (276005)
• Using a PROPERTY as a call parameter now compiles and executes as expected.

(5357)
• A query expansion of OCCURS DEPENDING ON tables now correctly reflects the current size.

02500813 (405134)
• The Outline view in the IDE is now available for all programs, irrespective of syntax errors encountered.

02297623 (285151)
• An ALLOCATE statement RETURNING a subscripted pointer now executes as expected.
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(369004)
• An ADD .. TO property statement now executes as expected.

(6503)
• The 'AT END' phrase of a file statement is now correctly distinguished from dereferencing syntax

specified in the same context.

(6149)
• INSPECT CONVERTING TO HIGH-VALUES now works as expected with the CHARSET"EBCDIC"

directive.

02317578 (286071)
• The CP preprocessor now respects the setting of the SOURCE-ENCODING Compiler directive.

02463619 (394012)
• Reference modification with an implicit length on the result of an intrinsic function now executes as

expected.

02269123 (258090)
• A MOVE CORRESPONDING statement with nested subscripting now executes as expected.

02473286 (395097)
• A background parse of COBOL source containing illegal code and characters before the main COBOL

program now produces full syntax checking consistent with previous releases.

02393247 (352074)
• INSPECT .. REPLACING more-than-one-byte BY SPACE is now producing the expected execution

results.

02521582 (411107)
• The CP preprocessor now correctly expands copybooks when COPY REPLACING is active and the

copybook name partially matches the replacing text.

02541659 (427024)
• A COPY REPLACING statement that results in a replacement line of more than 256 bytes is now

processed as expected.

(301078)
• Programs called with a CHAIN statement, which use their own file handler to access the filename

pointer in the FCD, now execute as expected.

(286017)
• A query of an item in a variable-length group with an UNBOUNDED table now returns the correct value.

02500660 (403177)
• Error message COBCH1554 More than 65535 statements in a paragraph. Cannot

produce debugging information is no longer reported for compilations where debugging
information was not requested (i.e., NOANIM specified).

02525192 (415062)
• Specifying dfheiblk and dfhcommarea as USING parameters on the Procedure Division header for a

program compiled with CISECM() now works as expected regardless of the case used.

02538907 (439076)
• A CALL statement using the 'DATA AT' syntax to pass a dereferenced parameter BY REFERENCE now

compiles and executes as expected.

(351091)
• For improved mainframe emulation, referring to the LENGTH OF a linkage item that does not have

addressability no longer receives a warning message.

02520501 (410013)
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• The user responses for the ERRQ Compiler directive are now all respected correctly.

(350010)
• COMP-1 and COMP-2 data types compiled with DIALECT"ACU" now receive a syntax error when a

PICTURE description is absent.

(296032)
• When the LANG environment variable is correctly set to match the source encoding of the COBOL

source file, the Compiler now completes the compile successfully.

(390023)
• The DIALECT"MF" Compiler directive no longer affects the user-specified setting of the SETTING

directive.

02449496 (390008)
• A STRING statement with 'DATA AT' operands now executes as expected.

(260018)
• Level 88s defined in a typedef may now be referenced through pointer dereferencing.

(377067)
• A CALL ... BY VALUE operation of certain numeric types, which is not allowed on the IBM mainframe, is

now correctly flagged under a mainframe dialect.

(310004)
• $if syntax is now processed correctly in all cases.

(318040)
• For better mainframe emulation, a data declaration specifying 'OCCURS UNBOUNDED' without a

minimum value is now accepted without error.

(414182)
• When using a typdef-item at pointer that was not unique in the typedef group, the Compiler compiled

without error; however, the pointer sometimes dereferenced at the incorrect address. This scenario now
produces a COBCH0005-S User-name not unique error message.

(415140)
• The reserved word FIXED is now treated as context sensitive, enabling you to also use it as a data

name, and ensuring better emulation of IBM Enterprise COBOL.

02526399 (409102)
• The DISPLAY-PICU(UTF-8) option now operates correctly with OUTDD when using Enterprise Server.

(297005)
• A new Compiler directive, ALPHA-LIT-CONT, determines whether continuation of non-numeric literals

includes spaces up to the right margin, or simply to the end of line.

(380072)
• A DECLARE value can now be expressed as an arithmetic expression in native COBOL.

(386138)
• The INITIALIZE condition-name syntax erroneously compiled without error. This now correctly

returns a syntax error for all scenarios.

02468662 (394064)
• An INSPECT statement used inside a class method no longer causes generation of invalid .NET or JVM

code. (This problem did not apply to procedural COBOL programs.)

02504599 (403183)

Containers

Back to the list
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• We strongly recommend that you create Micro Focus base product images with the bld.sh script using
the provided Dockerfile/Containerfile. Images created using alternative methods might fail with the
message 245 There are no valid product licenses unless the image includes the
CONTAINER environment variable. This release ensures that the provided Dockerfiles/Containerfiles
include this environment variable.

02555217 (439070)

Data Tools

Back to the list

• The Data Tools editor could display incorrect record numbers for variable sequential files following a
Find operation. This has been fixed.

02516058 (411005)
• In the Data Tools editor, there was an issue with viewing the last page of records in a sequential

variable file when the Quick final page preference setting was enabled and the file was defined with a
minimum record length of 0 or a large variable record size range combined with a large Records per
page preference setting. This has been fixed.

02487096 (397034)
• The performance of the Search > Go To navigation feature of the Data Tools editor has been improved

for variable and line sequential files.

02399254 02480008 (399043)
• The Data Tools editor Filter could timeout on large datasets opened through Fileshare, this no longer

occurs and the Filter operation can now be stopped using the Stop loading button on the status bar.

02368849 (313029)
• Editing/deleting line sequential file records no longer hangs when using Date File Tools.

02239120 (259127)
• When attempting to open data sets in the Data File Editor, file names containing a $ sign are no longer

incorrectly trimmed.

02194216 (221086)
• Data File Tools no longer attempts to open unrecognized file formats. Instead, an error message

appears explaining which format is invalid.

02308449 (281015)
• You can now copy hex values of selected records from the unpacked rows at the bottom of the screen

using the Copy Hex option available on the context menu the Edit menu. This option is visible only
when the hex toggle is enabled.

02396732 (352067)
• When copying a record to an external destination, the NULL Byte character is replaced by a character

specified in the Preferences dialog box. The default replacement character is a period (.).

02396678 (350053)
• The flickering of text within the DSN filter, when using the Data Explorer in the Data File Editor, no

longer occurs.

02155507 02380648 (224010)
• The Toggle Hex function now shows hexadecimal values under each line in the editor, not only the

selected one.

02342260 (297080)
• Field values of the Data File Tools File Information dialog box can be selected and copied to clipboard.

02396730 (352047)
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• When using the Data Explorer to open data sets, the DSN filtering and Fileshare settings now persist
when opening multiple files.

02396643 (351058)
• Horizontal scrolling in files with variable-length records did not work as expected when a short record

was selected. This is now fixed.

02150974 (202028)
• It is now possible to start mfdatatools2 from the command line to open a catalogued file from an

enterprise server region.

00501248 (71267)
• In the Data File Editor, a preference has been added to specify the maximum number of requested data

sets in the Data Explorer view. If a catalog contains more data sets than the maximum requested
number, a More data sets in catalog stub appears at the end of the list.

02396657 (350052)
• You must configure a TS model to ensure that Data File Editor correctly honors file locking across all

enterprise server regions in a PAC.

02529725 (413062)
• Previously, the DFCONV utility would produce an error when converting sql:// database files. This

has been fixed.

02497741 (403103)
• A performance enhancement has been made when listing PDS members within the Data File Editor.

02380628 02381204 (331003)

Debugger

Back to the list

• Debugging a statement that goes up to column 255, with the Autos window active, now works as
expected.

02289017 (271031)
• Expanding a dereferenced group item in the debugger now correctly shows the data for subordinate

items.

(363158)
• Previously, CBL_DEBUGBREAK did not invoke the debugger in .NET COBOL applications. This has

now been fixed and the built-in "Choose Just-In-Time Debugger" dialog box appears during invocation.

02388923 (348042)
• An issue has been fixed where the list of processes for 'attach to process' debugging could be displayed

incorrectly.

02458536 (386153)

Dialog System

Back to the list

• An issue with the dialog system painter clearing the screen when resizing a control has been resolved.

02367685 (330012)

Documentation

Back to the list

• Information on CICS internal transactions have been added to the product Help. See CICS Internal
Transactions in your product Help for more information.
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00367280 (13485)
• The ENDEVOR_DSNQUALIFIER and CHANGEMAN_DSNQUALIFIER parameters specify a HLQ and

their values must be limited to 8 characters in length. This has been clarified in the product Help.

02477878 (393134)
• The product Help has been updated to provide a description for the Data Set Services error

message MFMDS015E.

3206480 (12288)
• Enterprise Server security configuration options have been updated. See Security Configuration

Custom Configuration Information in your product Help for more information.

(411024)
• Information on configuring an OpenLDAP server has been updated. See Configuring the OpenLDAP

server in your product Help for more information.

02387889 SF:02437494 02437494 (356021)
• The CASESM Security Manager was part of the legacy security model used in the Net Express and

Server Express 5.0 and earlier products. As part of this, the legacy ESMAC user interface pages had
Security Keys as configurable options. In ESCWA, these can only be accessed by the Client Web API
and are not available in the ESCWA user interface pages that are equivalent to the corresponding
ESMAC pages.

02276034 (259095)
• The OSESM tracing option has been added to the configuration information in the product Help.

02145921 (202197)
• The PL/I documentation has been updated to include information for the mfexecpp Utility.

00368502 (11640)
• The product Help for optimizing the performance of the CICS Terminal Control has been corrected.

3239997 (12590)
• The tutorial CICS Web Service Provider from JSON has been updated to provide additional guidance

for the user.

3218247 (13347)
• The casrdtup utility supports the DEFINE and DELETE commands only. 

Note: The combination of DEFINE with the command line option /o can be used to overwrite
existing definitions as an alternative to ALTER.

02480002 (401027)
• Setting ES_PRODUCTION=Y will prevent debugging on Enterprise Server regions.

02208272 (346026)
• The documentation sample in the Using CobolBean for Instance Data Java topic has been corrected.

(409036)
• UNIX documentation has been updated to correct the case of the mfcatxml command.

02386876 (335024)
• The product documentation has been updated with the current name and contact information for Micro

Focus Customer Care. Any instance of the older terms for customer support remain in the
documentation because it is present within the product itself.

(377012)
• The SQL Server RM Switch Module topic has been updated to remove the [directives] option for build

mssql. The option is not valid and ignored by the system.

3172383 (13152)
• The documentation has been corrected to describe the duplicate cursor effect.
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3172533 (11320)
• The product documentation now correctly states PF_RO_CURSOR=8 as default when using

BEHAVIOR=MAINFRAME with SQLServer.

00372417 (12688)
• The product documentation now correctly lists the MVSSPLPB utility in upper case.

02328509 (351109)
• The documentation has been updated to include information on syntax and examples of usage for the

PUTENV Dynamic File Allocation facility. 

(207051)
• The product documentation clarifies that the Serial Scheduling option for defining an IMS Transaction is

not supported.

00365817 (13338)
• The UNIX instructions for creating ODBC data sources to use when connecting to a PostgreSQL

database server have been corrected.

00373755 (12675)
• The IMS Error Message IMSRT0048E has been documented in the product Help.

02227051 (245093)
• The documentation has been corrected in respect to enabling JIT debugging in Eclipse, on Linux\UNIX

platforms.

(365015)
• The To convert Net Express projects to Eclipse projects cheat sheet is no longer available on UNIX-only

products.

(238031)
• The documentation has been updated to highlight the requirement of associating a region with a project

if that region was created using one of the available enterprise server templates.

02152983 (256022)
• Instructions have been added to the Documentation that detail using Ant to build selected files in a

project, from the command line.

02212776 (304089)
• The sample Java code in the documentation topic Examples of Calling COBOL From Java  has been

corrected.

02509559 (405065)
• The documented description of the SSH Only remote host connection has been amended to explain the

limitations when using the Console view for output.

(464063)
• Some minor documentation amendments have been made to the IMTK tutorial SOAP Web Services.

(415185)
• An entry has been added to the Containers known issues and restrictions documentation concerning

memory issues under Windows 10.

(297140)
• Some of the COBOL cheat sheets in Eclipse have been updated/corrected.

(238037)
• Error message text for COBCH1882 in the has been updated.

(425030)
• The imtkmake -genclientjson command has been updated in the Eclipse documentation.

02368079 (314035)
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• The Data Files Tools tutorial has beenupdated to correct import instructions in Eclipse.

(319006)
• The documentation has been updated to show that only under an MF dialect can you omit the Working-

Storage Section heading.

3245726 (28060)
• Documentation for the CBL_STRING_CONVERT library routine has been enhanced to include

information on converting from Base64 ASCII or EBCDIC to Base64 BINARY, and vice versa.

(395072)
• The documentation has been updated to clarify support for the following: the CBL_GET_ERROR_INFO

and CBL_CREATE_STACKDUMP library routines, the stackdump_on_error tunable, and the
cobgeterrorinfo function.

(385041)
• The cob command examples in the documentation have been updated.

(403044)
• New documentation has been added that gives more detail on how to use the CBL_CTF_* library

routines. See Using the CTF Library Routines in the product documentation for more information.

(264040)
• The PL/I documentation has been updated to provide reference information for the -bifprec compiler

option.

02268330 (259038)
• The Micro Focus Unit Testing Framework documentation has been updated to explicitly state that the

MFUPP preprocessor is intended for use only within the confines of the testing framework.

02259026 (258085)
• Some of the screen shots in the MFDBFH documentation have been updated to show MFDBFH-

specific URLs in ESCWA.

(301083)

Eclipse IDE

Back to the list

• A problem that prevented command-line-based code analysis rule execution from completing
successfully was identified in the generation of linked resource information in the COBOL build files.
This has been fixed.

(297077)
• An issue was identified when using the spinner controls on the Spool Queue and Catalog tabs in

Eclipse, where entering invalid large numbers caused unexpected truncation of the value. This has
been resolved.

02452535 (387056)
• A problem was discovered when deserializing SQL settings for PL/I projects for display in the Eclipse

UI. This has been resolved.

02292826 (264083)
• An unexpectedly low maximum limit was being placed on the LRECL and BLKSIZE fields of the New

Catalog Entry dialog box. This has been resolved, in that large values can now be used.

02289452 (258151)
• An issue has been fixed with PL/I Code Coverage and Enterprise Server, which was preventing

coverage information being generated correctly when the region was stopped. 

(6964)
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• An issue was identified where compiling dependent programs of a specified copybook could fail when
dependencies spanned project boundaries. This has been fixed so that all dependent programs can
now be built.

02514846 (421007)
• A code issue was stopping the SQL (and CICS) preprocessors from being used when the initial

indexing phase was being run after project import (a process that determines the copybook usage),
when no .idy files were present. This has been resolved so that the preprocessor should now be
invoked and copybook usage information harvested.

00470009 (58319)
• A problem was identified with the paste functionality in the COBOL editor when Smart Edit Mode was

enabled, where the paste operation was not correctly taking into account the source format of the
document being edited (and so attempted to preserve the right margin when it shouldn't have been
doing so). This has been resolved.

(365196)
• An issue where Japanese text in a JCL file was garbled when the JCL was submitted through Eclipse

has been resolved.

02521298 (411034)
• An issue has been resolved where enterprise server region XML files were failing to import when using

the IDE-generated Dockerfile and associated script.

02398225 (364091)
• In Eclipse, the background parse of PL/I files is no longer hanging when the wrong margins are

specified for the active source file.

02332071 (297031)
• An issue has been resolved where the Configure Enterprise Server Run-time Environment dialog

box no longer adds an extra entry into the .rtc file, which was causing it to be invalid according to the
XML schema.

(393143)
• An issue has been fixed where hover text sometimes did not work when debugging source files from a

network share.

02213842 (251008)
• The generated Dockerfile helper scripts have been updated to use the --replace flag when calling

mfdepinst.

Note: If there is a pre-existing helper script in the project, it will need to be deleted before re-
running the New Dockerfile Wizard to generate the new script.

(362004)
• The generated Dockerfile helper scripts have been updated so that they fail a Docker image build when

an error is encountered.

Note: If there is a pre-existing helper script in the project, it will need to be deleted before re-
running the New Dockerfile Wizard to generate the new script.

(364010)
• Subscripted variables are now displayed correctly in the Variables window. Previously, they did not

when the debugging source files did not match the location specified in the IDY file (i.e., the source files
were moved after compilation).

02214996 (271021)
• An issue where Japanese text was not displaying correctly in the Spool and Catalog views has been

resolved.

(386023)

40 | Resolved Issues



• Colorization of string literals in the COBOL editor has been improved. Text is only colorized as string
literals within the code area and not within the left or right margin.

(10010)
• Generated dockerfiles may contain entries for installing xterm into the image. This is to enable certain

debugging scenarios.

(301110)
• Options in PL/I launch configuration that don't apply to the PL/I language have been removed.

(426032)
• Within the JVM COBOL debugger, a variable-length field now shows the odoslide optimized data.

02167560 (220023)
• An issue when evaluating COBOL table elements nested in grouping variables, with subscripts, has

been fixed.

02028149 (346031)
• The Run to Line debugging option has been added to the context menu of the COBOL and the COBOL

Copy View editors when debugging COBOL JVM projects.

02229815 (301049)
• Run to line debug support is now available for JVM COBOL projects.

02229815 (246120)
• An issue where the cursor jumps to a breakpoint line when hovering over variables has been fixed.

02407213 (363025)
• The Extract to Copybook option now flags file names that include apostrophes as invalid.

(7248)
• Within Eclipse, conditional fields are now updated in the Variables and Expressions views after an

update of a related elementary field.

02296412 (258266)
• The version of Ant that is shipped with COBOL development products is now version 1.10.12; at the

time of writing, it does not have any reported vulnerabilities.

(296038)
• An issue has been fixed so that enterprise server regions now correctly show their output console

information. Previously, where regions had stored credentials at the time the IDE was started, they
would fail to output any console information.

(258191)
• Error messages are now parsed correctly so as to avoid crashing the IDE.

(427004)
• The Console view in Eclipse now correctly shows information for an enterprise server (if the credentials

are valid).

(409082)
• JVM COBOL local variables are now shown in the Variables view during a debug session.

(393091)
• Within Eclipse, when generating a client COBOL program for a web service, the Bit Mode and Charset

properties are now honored correctly.

02483744 (397005)
• The Automatically find new updates and notify me preference is turned off by default to prevent a !

MESSAGE Unhandled event loop exception. Several default update sites have also been removed
during installation.

02319011 (285069)
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• In the Eclipse editor, if the vertical or horizontal split functions are enabled and then removed, syntax
highlighting continues to work. Previously, you were required to reopen the source file for syntax
highlighting to work.

02328546 (297008)
• The Preview Margin Style setting of the PL/I Formatting Preferences now persists after you apply the

setting and then re-open the Preferences screen.

(399009)
• A new option enables you to set COBOL keyword conversion to upper case, lower case, or as-is during

Code Cleanup.

(451073)
• Support of Micro Focus base images has been improved by adding a new wizard page to allow users to

select the base layers used in a generated Dockerfile.

02398225 (365108)
• You can now set conditional breakpoints within JVM COBOL programs; see Setting conditional

breakpoints and watchpoints  in your product Help for more information.

02178115 (355027)
• Dependency was not being updated when source files were modified external to the Eclipse IDE. This

has been addressed by a new option in the preference (Micro Focus > General) which, when selected,
updates the information when the resource is refreshed using the Refresh context menu item or by
pressing F5 on a resource in the explorer views). The dependency information will also be updated
when the file is open in an editor window and is modified externally.

02445610 (393008)
• The values of COBOL JVM variables can now optionally be displayed as hexadecimal values and byte

values. The inclusion of these value formats can be configured using the Value display options group in
the Micro Focus > Debug preferences page.

02229819 (246121)
• A problem that prevented the UnGroup menu option from being enabled has been fixed. Ungroup is

enabled for group items only. It removes the current group and places its group children one level
above.

02356137 (307002)
• Table variables in JVM COBOL programs are now displaying the correct value for subscripted and index

fields, both in the Expressions view and in hover mode over the variable. Also, table variable values are
now automatically changing in the Expressions view when the index is updated. The supported
expressions are:

- data-item(numeric)
- data-item(counter-data-item)
- data-item(operand operator operand)

Where operator is an operator for arithmetic operation (+, -, *, /) and operand is numeric or counter-
data-item. Multidimensional tables are also supported.

02153242 (203116)
• A new option has been added to the Search view for COBOL JVM projects - COBOL JVM Search

Presentation. It toggles between two types of presentation of the data: one that you may be familiar
with when working with Java projects, and one familiar when working with COBOL projects.

02290437 (259158)
• The Spool and Catalog views available in the Eclipse IDE have been enhanced to make them more

usable.

(293045)
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• For COBOL JVM projects, the Variables view now shows the value of the first 32 bytes of the memory
block pointed by the pointer. Also, a new pointer expression is available in the Expressions view for
COBOL JVM projects (this was already available for native projects): expression data(x:y)my-
pointer at my-pointer queries the memory block pointed by the pointer, where x is the starting
offset of the memory block, y is the number of bytes to query and my-pointer is the name of pointer
variable.

02153242 (321036)
• A new option, Refresh Service, has been added to the Web Services and Java Interfaces context

menus. Use the Refresh Service option to update the bitism of the program for an existing Web
Service or Java interface after changing the bitism of the Eclipse project or the COBOL program.

(294014)
• A new option is available from the X Font preference of the Preferences > Micro Focus > Debug

dialog box: select Use X Server font from the drop-down list to ensure that the application being
debugged through the X window uses the default font configured for the X Server.

02410279 (363047)
• If you attempt to create a self-contained unit test for a program that is already under test for an existing

self-contained test in that project, you are prompted to overwrite the existing test or select a different
program to put under test.

(222044)
• A new option that enables you to export code coverage results in a .tcz file has been added to the

Code Coverage view in Eclipse.

(5183)
• A new preference is available that, when selected, automatically adds line numbering to your program

when it is saved. This preference negates the need to use the Renumbering option when editing a
program that already has line numbering in place. The preference Perform line numbering on save is
available from Window > Preferences > Micro Focus > COBOL > Editor > Line Numbering.

02285269 (260138)

Enterprise Server

Back to the list

• Now users who have overlapping long names like USER1234 and USER12345 will not have overlapping
permissions when they have distinct mapped short names.

02529441 (440070)
• In Enterprise Server External Security Facility (ESF), requests to generate a passtoken (including for

RACF-style passtickets used by DCAS) could sometimes be rejected as unauthorized attempts to
create surrogate passtokens even though the passtoken request was not for a surrogate. This was due
to a case mismatch between the request and ACEE. This has been fixed.

02433532 02442474 (399097)
• The ESF could corrupt the credentials used to connect to an LDAP server when auditing was enabled,

causing a critical security failure and preventing enterprise server regions from starting. This has been
fixed.

02518028 (415116)
• MLDAP ESM now supports the use of the mfsecret: syntax for retrieving the security manager

credentials (authorized ID and password) from the vault. Those fields in the Security Manager definition
in ESCWA can be specified using the forms:

        mfsecret:configuration-name:secret-path

or:

       mfsecret:secret-path
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02548082 02554256 (440042)
• Mfsecrets crashed when running as multithreaded. This has been fixed.

(381004)
• A problem that prevented the AES provider on big-endian platforms from correctly reading vault secrets

has been fixed.

(430032)
• An incorrect signal 11 was generated from mfsecrets when getting the username for audit. This has

been fixed.

(382026)
• For Enterprise Server LDAP-based security, two new options, [Operation] group membership uses

short name and [Operation] search users by short name, permit applying user and group data to
users known to that Security Manager only by their short name (the Enterprise Server user ID). See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

02344601 (301036)
• In ESCWA on the Catalog page, you can now use the Line Wrap switch to toggle line wrapping for long

lines.

02289615 (258187)
• The ESCWA SEPs page displays Transient and Debug SEPs.

(327011)
• In ESCWA, accessing the Catalog file data has been improved by modifying the page layout.

02154749 (202107)
• In ESCWA, focus would not be put into modal dialogs when opened. This has been fixed.

01995433 (156067)
• ESCWA now displays more clearly when operating in Windows high contrast mode.

01995438 (161036)
• In ESCWA, the maximum height of list menus have been limited so that they do not overflow the screen

from their position, with a scroll bar to access all items.

02499988 (403117)
• The ESCWA and ESMAC JES Control page now carries out backend authorization checks against

cassub ESF resources.

(388029)
• In ESCWA, the SEP List page did not correctly sort the list by ascending or descending order. This has

been fixed.

02382568 (352007)
• ESCWA skipped entries on JES Catalog and the Spool DD display if the page size was greater than the

ESMAC limit. This has been fixed.

02501609 (407095)
• In ESCWA, some fields on the CICS DCT definition page have been fixed.

02340251 (296056)
• ESCWA was not able to bind to a hostname containing the w character. This has been fixed.

(296023)
• The ESM password is no longer disclosed in the /esf endpoint request.

02554256 (450046)
• You can now force the deletion of a JES Catalog entry if the first delete action fails.

02503936 (408004)
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• Reduced the number of password save prompts encountered when navigating ESCWA using the
Firefox Web browser. 

02324422 (306001)
• The IMS transaction threshold was not being disabled when the Use System Value was set. This has

been fixed.

02513511 (406144)
• In ESCWA, the FCT Backward and Forward Recovery will no longer be disabled when Use Catalog is

selected.

02416596 (364107)
• ESCWA failed to display Spool DD Entries on remote machines for versions earlier than 7.0 patch

update 11. This has been fixed.

02391716 (352054)
• When ESCWA was configured for TLS, it failed to stop when using escwa --shutdown from the

command line. This has been fixed.

02405704 02004795 (365071)
• In ESCWA, the Spool view now maintains the filter used between browser sessions.

02497901 (402095)
• Added missing annotation for ESCWA trace point.

02538486 (415187)
• ESCWA had duplicate CTF trace IDs. This have been fixed.

02524827 (409072)
• In ESCWA, an issue prevented the reselection of the same file twice when submitting JCL. This has

been fixed.

02198917 (222123)
• In ESCWA, the additional column File Size has been added to the catalog list view.

(403123)
• ESCWA might fail to disconnect from a Redis instance and reconnect to another. If this occurs you can

manually trigger a reconnect action by clicking the Reconnect button on the Scale-Out Repository
Information page.

(363105)
• ESCWA now reports the UUID of the PAC member that processes a batch job.

(289008)
• Implemented support for advanced job restart parameters on the JES job pages.

(271045)
• If ESCWA auditing is enabled from the Configuration page, or when ESCWA ESF auditing is enabled

from the Security > ESCWA Configuration page, then an auditing event is emitted, 2 19 (auditing
stopped), or 2 20 (auditing started). See Audit Event Codes in your product Help for more
information.

02412285 (365156)
• In ESCWA, you can now rename catalog data sets from the Catalog page. See Adding and Editing the

Catalog Entry in your product Help for more information.

02501074 (403136)
• In ESCWA, the “Historical Statistics Detail for Transaction” and “Historical Statistics” pages now

display time in milliseconds and the accuracy for latency and response information has been improved.

02504559 (405096)
• In ESCWA, the additional columns LRECL, RECFM, and File Size have been added to the catalog list

view.
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02527126 02527132 (409103)
• The spool job-name page has been split into General, Messages, DD Entries, and Job Steps tabs.

02527108 (411136)
• In ESCWA, the Socket Close field has been added to the CICS URIMap resource. See the Universal

Resource Identifier Map and Active Universal Resource Identifier Map topics in your product Help for
more information.

(363101)
• In the ESCWA page for displaying spool output, it is no longer possible to request more than 99,999

lines. This limitation has also been addressed in the ESCWA interactive API documentation.

02212126 (246026)
• In ESCWA, the IMS Transactions page now has additional columns for Class, Priority, and Process

Limit.

(252019)
• A new CGI threshold type has been implemented in Enterprise Server. This enables you to set up

threshold values for ESCWA and ESMAC requests by applying the global =CGI to all ESCWA and
ESMAC requests, or by specifying the corresponding casrdo or casrdj module that you want to
control.

(377073)
• MFDS no longer supports XA reconnect attempts.

(427068)
• ESCWA now supports merged spools. See Spool in your product Help for more information.

(246044)
• In ESCWA, the PCT Security flag is now displayed on the Active PCT page. See Active PCT in your

product Help for more information.

(335002)
• Resolved an issue with a mutex deadlock created when MFDBFH attempted to emit a message during

a cascd shutdown. 

02468209 (406002)
• An RTS 114 error related to CICS PPT RESCOUNT processing has been fixed.

02380883 (331015)
• A problem that caused Web Service client calls to fail after an upgrade has been fixed.

02320601 (307054)
• An intermittent Access Violation in mfredis.dll sometimes occurred when a batch job abended. This

has been fixed.

02328218 (296144)
• ECI transactions were not being committed at the end of task. This has been fixed.

02497005 (403085)
• An issue that resulted from pressing the Clear key following a EXEC CICS SEND PAGE command has

been fixed.

02423737 (375058)
• The user ID was not sent across on a Distributed Program Linking (DPL) from a CICS Web Interface

(CWI) request. This has been fixed.

02357738 (306068)
• The recovery of processes by casmgr now occurs in the same order in which they were terminated.

02449487 (389051)
• A bitism issue with the triggers provided with the product has been fixed.
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02554978 (449002)
• An issue with updating a transaction ID in ESMAC has been fixed.

(264059)
• A WEB RECEIVE SESSTOKEN sometimes threw an RTS 114 error in cascwi. This has been fixed.

(409046)
• CICS WEB SEND commands were sometimes directed to an incorrect communications process. This

has been fixed.

02394770 (351065)
• The _FROM option on the CICS START command can now be used with AMODE compiled programs.

Caution: Do this only when instructed to do so by Micro Focus Customer Care.

02340979 02547874 (297112)
• PAC performance optimization has been enhanced to avoid PSOR access when the _FROM option is

used on CICS START.

02541046 (425006)
• Temporary storage queues of type Process Local now work in AMODE applications.

02341118 (296055)
• Using the CICS TRANSFORM command within a pipeline handler program sometimes resulted in a

LANG ABEND. This has been fixed.

00365824 (13246)
• Dynamically enabling HSF sometimes resulted in shared memory corruption. This has been fixed.

(411104)
• In a PAC, closing an FCT that referenced a catalogued file sometimes resulted in a truncated filename

after 44 characters. This has been fixed.

02421476 (364152)
• In a PAC, multiple updates of the same CICS resource within the same millisecond could result in an

inconsistent state between different enterprise server regions. This has been fixed.

(90011)
• JES active job recovery in a PAC failed to mark the job as complete when the enterprise server region

originally processing the job was restarted. This has been fixed.

(402004)
• The casfile, casout, casstop, cassub, castran, and casutl commands now find the enterprise

server region successfully when mfds is started with the -b option.

02307940 02202467 (286003)
• An error message was unnecessarily exposing input credentials. This has been fixed.

02409369 (363126)
• When using casout, the /y option could fail depending on the order of options used. This has been

fixed.

02371843 (313041)
• In a CICS Web Interface, after the Analyzer is called, the decoder function now receives the data

unescaped.

02512069 (405161)
• An internal transaction (ITR) was not sent to a SEP that had an EZASOKET listener started. This

sometimes resulted in a close file request failing to be processed by the SEP running the EZASOKET
listener. This has been fixed.

02394276 (350047)
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• When using function shipping between two enterprise server regions, one EBCDIC and one ASCII, the
records are now correctly converted.

(405010)
• EXEC CICS DELAY was monitored for DEAD LOCK timeout, resulting in the transaction being killed.

This has been fixed.

02399944 (350093)
• The start CICS transaction was not producing the correct trace for HSF. This has been fixed.

02385015 (340004)
• When an XA issue occurred, the reason code was not always returned. This has been fixed.

02532560 (425053)
• An intermittent crash in casmgr has been fixed.

02431740 (377040)
• When sorting by Submitted, the spool records are now returned correctly.

02404702 02431279 (365041)
• When performing a NEWCOPY on a data table in a PAC, not all enterprise server regions in the PAC

reloaded the new member. This has been fixed.

02406797 (364015)
• An EXEC CICS RELEASE was cancelling a program even if the rescount was not 0. This has been

fixed.

02400119 (355025)
• When trying to load an ASM data table using castran with -b for AMODE, the pointers were not

always converted to AMODE addresses. This has been fixed.

02528581 (414049)
• When using EXEC CICS DELAY in an AMODE program a RTS114 could occur. This has been fixed.

02505696 02428286 (406176)
• Thresholds are now started before the XA start for a transaction has been issued, enabling the process

to be killed if the transaction is stuck in the Resource Manager.

02365811 (306124)
• When using a CICS Web Interface (CWI) Analyzer that was compiled with AMODE 31, an ABEND

MFPM would occur. This has been fixed

02427963 (374003)
• When using the CICS command castran with the -b option, the message was not sent to the

console.log file. This has been fixed.

02389970 (348041)
• In an HTTP CICS Web Interface (CWI) request with the analyzer returning a converter program to

execute, the decoder parameter for decode-data-ptr was not set. This has been fixed.

02432166 (377025)
• When multiple requests were made from the same browser, a new TCTS was allocated, resulting in an

SOS situation. This has been fixed.

02419170 02404921 (364124)
• When using EXEC CICS DELAY before EXEC CICS RETRIEVE and ENDDATA was returned as the

DELAY, it resulted in resetting the data sent to the application. This has now been fixed

02526457 (419004)
• When using TRANCLASS and refreshing ESMAC, the data sent to a started transaction could be lost,

resulting in ENDDATA returned on the retrieve. This has been fixed.

02526457 (451029)
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• An incorrect IOERR was returned from CICS READNEXT when the record was locked. This has been
fixed.

02526497 (413214)
• CESL now respects the case of the password entered. No upper-case translation occurs.

02501164 (407012)
• The sample exit program DFHUSYNC has been modified to not return cics-syncpoint-normal-88 by

default as this could overwrite the correct return-code set on a previous call to an RM.

02492604 (409026)
• If ES_ESM_PLTPIUSR is defined, programs in PLT/PI are executed under the ES_ESM_PLTPIUSR

user.

02472002 (407025)
• The RAS process is now correctly identified on a dump.

(385051)
• An issue where MQ Security Resources were prefixed when using ES_ESM_SECPRFX has been fixed.

02483959 (406062)
• Fixed a memory corruption that occurred when logging in-doubt XA transactions in the PAC.

02304565 02319810 (284038)
• Replaced ESF Admin API LISTRESOURCE with ESF Auth for querying MQ Security Resources.

02154003 (202145)
• Updated XID generation to support UTF-8 code pages with PostgreSQL.

02296723 (273006)
• A shared memory corruption issue occurred when reinstalling a TCPIP Service or URIMAP. This has

been fixed.

(204047)
• Improved error reporting when applying advanced configuration updates in a PAC environment.

(364113)
• The casesxml utility now provides a relevant error message when no work location is provided.

02531150 (413115)
• The casstop command output misleading error messages when immediate shutdown was used. This

has been fixed.

02490512 (403132)
• The dynamic region configuration updates occasionally failed to apply. This has been fixed.

(245030)
• If an enterprise server region contained $ES_SERVER in its configuration, then it would not be handled

by casesxml. This has been fixed.

02531150 (417037)
• Enterprise Server CICS now supports the MAPPINGDEV option of SEND MAP and RECEIVE MAP

commands.

02497790 (407132)
• Support has been added for the MILLISECS option of EXEC CICS DELAY.

02428286 (377024)
• A CICS distributed program link over SNA for which the target enterprise server region was unavailable

resulted in EIBRESP=ISCINVREQ instead of SYSIDERR. This has been corrected.

02249191 (255023)
• To improve efficiency, when an enterprise server region is configured with multiple RMs and a task uses

only one, no XA log is created for the transaction.
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02537701 (430016)
• When calling APPC functions, you could pass an invalid value in the first parameter which would result

in an error in the communications server layer. This has been fixed.

02428147 (372009)
• When using LU6.2 communications infrastructure between enterprise server regions, when a COMMIT

was executed by the originator, the target would incorrectly attempt to send a commit request back to
the region which sent the sync point request. This has been fixed.

02339327 (296039)
• When using LU6.2 communications infrastructure between enterprise server regions, the processing of

SYNCONRETURN on a Distributed Program Link was preventing switching between remote systems
(SYSIDs). This has been fixed.

02336501 (296104)
• When using LU6.2 communications infrastructure between enterprise server regions, an ABEND in the

target region would result in the SEP which was processing the request hanging. This has been fixed.

02287147 (259103)
• When using LU6.2 communications infrastructure between an enterprise server region and mainframe

CICS, sync point requests executed on the target would result in an orphaned UOW. This has been
fixed.

02322602 (297014)
• A DPL request from Tuxedo over LU6.2 could result in an RTS 114 error being reported. This has been

fixed.

02531060 (421001)
• HSF records for Java ECI transactions now display the transaction name instead of CASECIP.

02338437 02353043 02394280 (296126)
• Changed the first occurrence of CASA_ECI_Function in HSF records for EXCI calls to show the

transaction ID if one is specified in the TRANSID option on the EXEC CICS LINK.

02383644 (339001)
• The latency value in HSF records could be incorrect for transactions started via DPL. This has been

fixed.

02504559 (407143)
• Some Redis connections from castmc, castrc, and cassi processes were not being disconnected

and remained open. This has been fixed.

02198949 (222162)
• The casstart utility now accepts variable wait times for the /w parameter. See casstart in your

product Help for more information.

(365010)
• HSF now reports that 100% of transactions meet performance criteria when no transactions are

measured for that period.

(385065)
• Dynamic Debugging failed on secure enterprise server regions with certain security configurations. This

has been fixed.

02408468 (363059)
• The JCL command cassub is now designated as a system program and as such will not be cancelled

by runtime container de-initialization.

02356121 (307019)
• Issues with CICS NEWCOPY and Phase In when used in a PAC environment have been fixed.

(259078)
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• Enterprise Server Clustering is now deprecated. Micro Focus recommends that you adopt the Scale-
Out Performance and Availability Cluster (PAC) solution for your clustering requirements. See Scale-Out
Performance and Availability Clusters in your product Help for more information. In addition, the
LOCKDB feature has been added to replace the functionality of the Enterprise Server Cluster Global
Lock Manager (GLM). See Enterprise Server LOCKDB for more information.

(363157)
• An enterprise server region sometimes crashed after MFCS and the ADMIN SEPs were killed. This has

been fixed.

02415369 (364089)
• A new CGI threshold type has been implemented in Enterprise Server. This enables you to set up

threshold values for ESCWA and ESMAC requests by applying the global =CGI to all ESCWA and
ESMAC requests, or by specifying the corresponding casrdo or casrdj module that you want to
control.

02426463 (370004)
• The spool view page no longer displays errors even if another spool page has not been loaded.

02514961 02518028 (407109)
• You can use the new ES_HARD_KILL_PROCESS environment variable to modify how Enterprise

Server kills a process. See General Enterprise Server Environment Variables in your product Help for
more information.

02365440 (355015)
• Added a new Retrieve action to the caspac utility to enable you to retrieve binaries loaded on an SOR.

See caspac in your product Help for more information.

(284104)
• A new /z parameter has been added to the following commands-line utilities: casfile, casout,

casstart, casstop, cassub, castran, and casutl. The parameter enables you to pass user
credentials through an interactive prompt or a redirection from the console. See the respective
command-line topics in your product Help for more information.

(303013)
• In Enterprise Server with LDAP-based security, the effect of the value 0 for the attribute microfocus-

MFDS-User-MTO-Timeout was documented incorrectly. When this value is 0, the enterprise server
region's default user timeout is used. See Defining a User with LDIF in your product Help for more
information.

02305957 (276010)
• The following environment variables can now be configured as properties on the ESCWA Advanced

Region Properties page: ES_SEP_DORMANT_TIME, CAS_SRV_CANCEL, and
 ES_MAX_CATALOG_LINES.

(348002)
• The following environment variables can now be configured as properties on the ESCWA Advanced

Region Properties page: ES_DDBG_PORT_RANGE, ES_ESMAC_DISP_MAX_OVERRIDE, and
ES_SOR_RETRIES.

(306023)
• The supported list of cipher suites has been updated to TLS v1.3.

02320601 (401139)
• EIBCALEN now has the correct value after an invalid transaction from a previous CICS RETURN

transid.

SF:# 02416565 (387026)
• PDS member names are no longer be truncated in the Data Editor when PDS names and member

names are longer than 44 characters combined.

02358793 (306041)
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• An issue that prevented the user ID from being found and that then failed to report this back to the
application has been fixed.

02459379 (395007)
• An RTS 114 error on a CICS LINK to a remote system has been fixed.

02336344 (297044)
• CICS FILE OPEN was returning ILLOGIC when user catalog was enabled. This has been fixed.

02418777 (364137)
• An issue with EXEC CICS VERIFY PASSWORD when the application was compiled with the AMODE

directive has been fixed.

02461716 (393128)
• The EXEC CICS WEB READ HTTPHEADER and WEB READNEXT HTTPHEADER commands no

longer include trailing spaces in the value returned in the VALUELENGTH field. For example, the
VALUELENGTH for a header with a value of "myValue " (three trailing spaces) is now 7 instead of 10.

02451501 (406070)
• When running with futex support, enterprise server regions would no longer start due to a logic error.

This has been fixed.

(308024)
• In TRANCLASS enterprise server regions, non-TRANCLASS Temporary Storage Queue (TSQ)

processing can now be enabled by setting ES_TRANCLASS_EXCEPT_TS=Y.

(387013)
• Support for TS queues of type Exclusive has been improved by correcting error conditions and now

retaining queue recoverability after a DELETEQ.

(386014)
• A bug in the castsc process meant that it could trap in casstore when a terminal disconnects. This has

been fixed.

(368001)
• In a PAC, access to an FCT could immediately reopen an FCT that had just been closed by another

enterprise server region. This has been fixed.

02421476 (375005)
• A WRITEQ TS using the REWRITE option against a non-existent queue was incorrectly returning

ITEMERR instead of QIDERR when running with ES_TRANCLASS_EXCEPT_TS=Y. This has been
fixed.

02515519 (405171)
• An issue with the start initiator button not being correctly disabled when a user was not authorized for

the casout resource (OPERCMDS) has been fixed.

02503261 (401173)
• A loop that occurred when trying to recover PIDs after MFDBFH lost the connection to the database has

been fixed.

02373280 02362273 (322009)
• Option USERID is now supported for EXEC CICS QUERY SECURITY.

02419858 (363211)
• MQ security was being disabled when Allow unknown resources was enabled. This has been fixed.

02328521 (288019)
• When a process dies in a PAC, casmgr in the recovery process tries to call MFDBFH to recover the

process, close all files opened by that process, and release all the locks. If the connection to the
database was lost, the call to MFDBFH would fail and the process only recovered if the connection was
restored at region termination. Updates in this release now keep track of the process that could not be
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recovered and retries when the connection is restored. On region shutdown, all orphan ITRs that
belonged to the current region are now removed. At start up, all orphan ITRs that were targeted to the
region are removed.

02345487 (303043)
• An incorrect HSF latency calculation when the transaction was using a TCPIPSERVICE has been fixed.

02439855 (387136)
• When using DEFINE LIBRARY, casrdtup was hanging. This has been fixed.

02422104 (372043)
• You can now specify thresholds for ESCWA and ESMAC requests using the new type CGI and by

specifying the casrdxxx module name or a global threshold =CGI. This ends the request abnormally if
the threshold is exceeded, and stops the admin SEPs from being blocked on long requests accessing
ESCWA or ESMAC.

(372055)
• Invalid messages have been removed from the Catalog Display when details are enabled.

02501609 (405074)
• A local memory leak that occurred when logging XA transactions in a PAC has been fixed.

02319834 (285102)
• An issue with MQ security checks when security resource prefixes are used has been fixed.

02483959 (397010)
• Ambiguous MQ security rules failed to enable security checks. This has been fixed.

02375426 (314055)
• The subsystem security switch was not being set to OFF when the MQADMIN class was not defined.

This has been fixed.

02483959 (399003)
• All authentication checks for Dynamic Debugging operations are now skipped if the casdebug entry is

not available under the OPERCMDS security resource.

02367824 (314007)
• An issue with MQ security console messages not containing the actual resource being checked has

been fixed.

02483959 (399002)
• Return code handling for create process requests on Windows platforms has been improved.

02290153 (307032)
• When using LU6.2 communications infrastructure between enterprise server regions, an ABEND raised

by the target application would result in subsequent attempts to establish a conversation to fail. This has
been fixed.

02339327 (297043)
• EXEC CICS START requests which expired immediately were being delegated to another process for

scheduling. This has been fixed.

(386090)
• When invoking a program over a SyncLevel 2 connection which executed an EXEC CICS SYNCPOINT,

the backend would raise an ISCINVREQ condition and the session state would subsequently result in a
SYSIDERR on the client side.

02312326 02329428 (285057)
• HSF reported latency for incoming remote DPL requests were not being reported correctly. This has

been fixed.

02455011 (392023)
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• Windows Performance Counters now work using a V2 provider DLL and will appear in Performance
Monitor under 'Micro Focus Server System V2'.

(286029)
• Security checks are now supported for Dynamic Debugging operations. Checks are carried out against

the casdebug entry under the OPERCMDS resource class.

02337725 (296095)
• If an enterprise server region is running in a PAC with both IMS and CICS features enabled, then single

sign-on is enforced for both CICS and IMS. If you want to change the behavior, set
ES_CICS_SINGLE=N and/or ES_IMS_SINGLE=N to enable the same user to sign on to multiple
terminals for CICS and/or IMS.

(345001)
• When using casesxml, if the enterprise server definition has been exported using the -c option then

you must import using the -c parameter.

(351045)
• If an XA commit verb returned retry n times, where n is the configurable number of retries, then the

DSNRLI function incorrectly received a return code of zero. This has been fixed.

02495509 (408003)
• An issue with the TType page (Signoff attribute) affecting ESCWA and ESMAC has been fixed.

(402014)
• In ESCWA, the Spool Completed field did not display the correct time. This has been fixed.

02470813 (393069)
• Attempting to delete a job in the input state from the Spool in ESCWA would intermittently fail. This has

been fixed.

(394029)
• The JSON ESMAC spool details module now reports the UUID of the PAC member which processed a

batch job back to ESCWA.

(293036)
• The ESCWA API call /native/v1/regions/host/port/region/users/resource has been

fixed.

02382647 (340024)
• An issue existed when filtering the spool without wildcards. This has been fixed.

02486979 (397072)
• In ESCWA, when displaying JES Catalog entries the record count information is now correct.

02209327 (246002)
• An issue where ESMAC display Count Override was not being applied when viewing files from the job

list view has been fixed.

(406141)
• In ESCWA, the limit of jobs that can be deleted from the spool has been increased to 100000.

02332690 (291038)
• Both ESCWA and ESMAC JES Control pages now carries out back end authorization checks against

cassub ESF resources.

02427674 (375006)
• Added support for passing advanced job restart parameters through the Spool Job View page.

(273030)
• Added the ESCWA JES Default User Job Submission property to the Advanced Region Properties

page in ESCWA. This property changes the default user behavior for JCL Job Submission through
ESCWA and the IDE.
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02378712 (365132)
• When using the OpenLDAP client library on Linux, if the Timeout parameter is set in the [LDAP]

configuration section, the MLDAP ESM Module will instruct OpenLDAP to set the
TCP_USER_TIMEOUT socket option to correspond to the Timeout value. This improves OpenLDAP's
ability to honor the timeout. However, the TCP_USER_TIMEOUT socket option only applies when sent
data goes unacknowledged, or data cannot be sent because the server's receive window is closed.

02446931 (387139)
• In some circumstances MFDS incorrectly granted permissions. This has been fixed.

(365086)
• An Enterprise Server Security Manager using the MLDAP ESM Module with caching enabled no longer

incorrectly caches partial results when an LDAP search cannot return the full result set due to the
server's size limit on responses. The module will always switch to an LDAP paged search when
necessary, bypassing the cache. This corrects an issue where customers with a large number of
resource rules might sometimes get incorrect security results (typically access denied when it should
not be) after the first time that resource class was queried.

Note: If you cannot apply this fix, you can work around it by disabling caching for the Security
Manager. ESF caching, which is set in the Security properties for the enterprise server region, can
remain enabled.

02475614 (397047)
• Enterprise Server security did not always assign supplemental groups to users in certain configurations

with multiple Security Managers, Federation enabled, and All Groups enabled. This has been fixed.

02145921 (202146)
• The ability to change passwords through the OS ESM Module was broken in version 1.10.4 of that

module. That has been fixed.

02408023 02417238 (363081)
• Issues with changing passwords through the OS ESM Module have been fixed.

02408023 02425417 (370007)
• When using the OpenLDAP client library on Linux, the MLDAP ESM Module can now optionally set the

connection-specific TCP keepalive parameters (idle time, interval, and number of lost probes before
terminating the connection). See MLDAP ESM Module Custom Configuration Information in your
product Help for more information.

02446931 (385125)
• For Enterprise Server LDAP-based security, a new configuration option, [Operation] check

constraints for already-verified users, lets an MLDAP Security Manager deny sign-on for a user even
if an earlier Security Manager has chosen to allow the Verify request. See MLDAP ESM Module Custom
Configuration Information in your product Help for more information.

02346703 (297133)
• The esfupdate utility now supports the Micro Focus Vault Facility for retrieving secrets. See To Update

Security Manager Changes Using esfupdate in your product Help for more information.

02510669 (406066)
• When both BATCHONLY and LOCALTX are set to true, one-phase-commit batch jobs no longer trigger

two-phase commit connection in the recovery transaction.

02407338 (364098)
• At the end of a CICS transaction that calls batch programs, all opened cursors are now closed.

02423443 (369016)
• The XA ODBC switch module now gets the correct server status, enabling the Enterprise Server

RECONNECT feature to work correctly.

02408845 (362020)
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• XA switch modules that use OpenESQL now work correctly when the applications in Batch transactions
are compiled with XAID directive option.

02327393 (293012)
• The DB2 switch module now sets the PackagePath after switching to the user.

02269497 (258224)
• XA switch modules no longer return an MFDBFH registration error to Enterprise Server, ensuring that

non-MFDBFH transactions continue using the XA connection.

02452753 (385055)
• The correct OCI_ATTR_SERVER_STATUS is now used to query Oracle Server status.

02391332 (335016)
• XA recovery is now performed correctly for DB2 in-doubt transactions when the enterprise server region

is next started.

02474721 (402001)
• You can now build the SQL Server RM switch module on UNIX platforms. See SQL Server RM Switch

Module in your product Help for more information.

(365126)
• The Region Trace Control process (castrc) was incorrectly creating multiple connections to Redis

after a RD-NOAUTH return code. This has been fixed.

02319798 (335004)
• Intermittent CONNECT_ERROR issues occurred when accessing data from MF Directory Server via

ESCWA. This has been fixed.

02532852 (425068)
• A socket handle leak occurred if the connection to the MF Directory Server process failed. This has

been fixed.

02435329 (382013)

File Handling

Back to the list

• The performance the Data File Editor has been improved when navigating within variable-sequential or
line-sequential files accessed through a Fileshare server.

(401106)
• File Status no longer returns corrupt index file for a non-corrupt file, under high traffic.

02513640 (406155)
• A COBRT114 error no longer occurs when using read-direct on VB file header records.

02490607 (400074)
• Background changes have been made to the external file handler when dealing with sequential files.

(382072)
• Performance improvements have been made when navigating to the last page of a variable-length file in

the Data File Editor.

02476713 (394163)
• The OPEN INPUT of an optional file, which is not referenced in the JCL, now behaves as it does on the

mainframe.

02418838 (350105)
• Fileshare could crash when processing some unexpected sequences of operations for a connected

Data File Editor. This has now been fixed.

02409270 (365144)
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• In some scenarios, zombie processes could result in an incorrect reporting of open files in the system.
This has now been corrected to better detect when such scenarios occur.

(297118)
• It was possible for an ODBC/OCI exception (such as a connection timeout) to occur in the optimized I/O

thread when accessing files via MFDBFH. This could cause the process to hang, and so defensive
measures have been taken to resolve this.

02481017 (405157)
• An issue where MFDBFH would incorrectly return a 9/139 error when attempting to open a file that did

not have a key definition area specified in the FCD has now been fixed. The behavior is now the same
as it is on disk.

02394334 (350036)
• Oracle statements were previously using deprecated OciStmtPrepare calls, which meant that the

Oracle application failover/transaction replay could not be used. This has been updated to now use
OciStmtPrepare2.

02441885 (384027)
• A timing issue when closing the connection to the database caused an SEP to crash on region

shutdown. This has been resolved.

(254034)
• The time required to return after reading a large number of records from large files hosted in MFDBFH

was excessive due to the large number of SQL queries being executed. These queries have now been
optimized to improve performance.

02396919 (384007)
• The performance of filtering the Enterprise Server JES Spool has been improved when ordering the

content by Job ID while filtering by a specific Job Name.

02293524 02299724 (264085)
• Enterprise Server sometimes failed to recover processes that died after losing and then reestablishing a

connection to the database. To mitigate this, Enterprise Server has been updated to attempt recovery of
these processes at a later time in the event that the database connection cannot be reestablished.

(326009)
• SYSOUT SSTM data sets were being incorrectly marked as using an In-Memory record-locking strategy

when hosted within MFDBFH, which returned a 9/100 status due to multiple processes attempting to
write display statements to the data set. In this scenario, SYSOUT SSTM data sets now use the default
Table record-locking strategy.

(299014)
• MFDBFH has been updated to be sensitive to the FAN settings on an Oracle Database, and is now

immediately notified when the database attempts to drain connections. In this case, MFDBFH attempts
to establish a new connection.

(375030)
• When registering an XA connection with MFDBFH, the registration process attempted to connect to

each entry in the MFDBFH.cfg file to determine if it matched the details of the XA resource. Underlying
improvements have been made to reduce the number of connections made when the MFDBFH.cfg file
contains duplicate entries.

02459182 (390041)
• If the connection to an Oracle RAC environment was lost at a specific time, a COBRT114 error was

sometimes thrown in the XA Switch module. Additional checks have been added to the code to ensure
that this is no longer the case.

02366126 (350015)
• When using an Oracle database, if the connection was lost, the process failed to reconnect once the

connection to the database was reestablished. This has now been resolved.
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02410660 (363051)
• Oracle queries that issued searches against large files used a full-table scan, slowing performance.

Performance has been improved by instructing the Oracle optimizer do a range scan instead of a full-
table scan in this case.

02516560 (406164)
• Additional diagnostics information has been added to assist in determining the cause of an RC 3 on

MFDBFH recovery processing.

02344102 (299021)
• A WRITE operation that used ADVANCING mnemonic-name sometimes threw an error. Support has

now been added to handle WRITE operations with mnemonic usage.

02209654 (246009)
• Performance when filtering the Spool queue has been be improved in situations where the filtered field

does not match the field by which the queue is being sorted.

02516560 (410086)
• When a database ran out of available connections, stored procedures and functions were sometimes

lost. This release contains updates that reduce this risk.

02155281 (203093)
• A progress bar has been added to dbfhdeploy operations.

(381028)
• A new environment variable, MFDBFH_GRANT_USER_PERMISSIONS, has been added for Oracle

databases only to allow MFDBFH to grant execute privileges on types/procedures to specific users/
roles. This provides easier user privilege restriction on Oracle and creates a more secure environment
without having to manually modify the MFDBFH scripts. 

02459320 (389032), 02441860 (384006)
• Additional checks have been added to verify the integrity of the region/cross-region database tables

before running dbfhadmin -casprocess -recovery. If required, you are prompted to run
dbfhadmin -verify to fix the table integrity before recovery can continue.

02326339 (297036)
• A Y2W date comparison is now supported in EBCDIC.

02423850 (364166) 02326205 (285173)
• MJFTOOL now correctly converts EBCDIC to ASCII output when the file is LSEQ.

02393322 (350028)
• During a SORT, SUM now correctly works with MF_CHARSET=EBCDIC.

01909282 02349849 (124117)
• The DFSORT INCLUDE statement now supports the Y2U format with a constant.

02351201 (303076)
• A 9/139 file status no longer occurs when submitting a SORT job with an OUTFIL statement containing

FTOV and HEADER1 parameters.

02522665 (411123)
• An issue has been fixed where the TRAILER1 MIN and MAX functions were returning high values

instead of zeros when used on an empty file.

02539611 (421035)
• When using the OUTFIL statement under DFSORT emulation, RECFM is correctly set to FB

(previously, it was VB) during a COPY operation.

02353490 (303058)
• The discrepancy in MFJSORT VB Outfil LRECL checking has been resolved.

02501782 (406117)
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• The MFJTOOL SORT emulation's SELECT LAST operation now behaves correctly for VB files.

02474360 (395098)
• Generating SPLICE with KEEPNODUPS using an empty input file was generating an invalid output file.

This has been corrected to generate an empty output file.

02403474 (356016)
• The validation checks that were causing unexpected behavior in ICETOOL emulation have been

corrected.

02412147 (365082)
• MFJSORT now throws an error message when the unsupported DATE4 operand is used in the SORT

card.

02435356 02389969 (375072)
• A correction has been made to the temp/dump file creation of a SORT process.

(387134)
• The OUTFIL LRECL calculation has been corrected when there is a newline literal in the OUTREC

statement.

02500082 (402125)
• Support has been added for the ON(VALCNT,formatting) parameter of the MFJTOOL OCCUR operator.

02474081 (395127)
• The INCLUDE statement within a SORT now works with the SIGN-EBCDIC flag.

02366598 (314012)

HA Cloud Support

Back to the list

• The startsessionserver batch or script file used to start an HA Cloud session no longer launches
with CMSClassUnloadingEnabled in the Java options.

(382033)
• Additional logging capabilities have been added to the HA Cloud session server. You can set logging

levels for additional properties in hacloud.properties such as
logging.level.com.microfocus.zfe.enterprise.ConfigurationServiceEnterprise,
logging.level.com.microfocus.zfe.enterprise.ConfigurationLoader, and
logging.level.com.microfocus.zfe.enterprise.VaultAccess.

(375033)

IBM Language Environment for OS/390 & VM Support

Back to the list

• A fault in CEE3DLY that caused an COBRT227 error has been corrected.

02462693 (372005)

IMS Support

Back to the list

• A problem that prevented users from broadcasting a message to IMS terminals has been fixed.

01912390 (150003)
• A problem that erroneously caused a run-time error on start-up when a message-queue error was

detected has been fixed by replacing the run-time error with a console message.

02557482 (446006)
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• A problem that delayed transactions invoked via MQ-IMS Bridge when the MQ request queue was
nearly full has been fixed. In addition, sporadic transaction-not-found errors no longer occur.

02268086 (258040)
• A database no longer fails to close in certain situations when work has been done after a QC.

02030160 (166042)
• A problem that occurred when multiple XAs were used in IMS BMP programs prevented changes from

being committed to each XA separately, even when a 2-phase commit was requested. This has now
been corrected.

02287414 (260260)
• The IMS /REFRESH PROGRAM command now forces a QC for the next GU from scheduled MPPs

allowing MPRs to cancel loaded executable modules.

(303085)
• IMS intermittently failed to dispatch new work. This has been fixed.

(333001)
• Enterprise Server IMS TM erroneously dispatched new transactions while the DLI database was

suspended. This has been corrected.

(405164)
• A problem that caused IMS TM on 64-bit systems to continue dispatching when the database was

commanded to suspend has been fixed.

(410077)
• A problem that caused false SYNCPOINT failure reports during an IMS /REFRESH PROGRAM ALL

operation has been fixed.

02311796 (385010)
• IMS REFRESH command no longer causes a false XA error message for WFI transactions.

02311796 (319028)
• The existing ES_CESN_NO_OS390 environment variable now also applies to IMS. When set, both an

invalid user ID and an invalid password give return code 8.

02485549 (400037)
• An incorrect RX status code was sometimes returned when replacing a concatenated (LC|LP) segment

with different logical parent data, even when the virtual replace rule was specified. This has been
corrected.

02437342 (397002)
• A problem with MFS option 2 that occurred when no data was received from the screen prevented the

input segment from being compressed out of the input message even when input literals were defined.
This has been corrected.

02390758 (386139)
• To correct a problem that caused data to be mapped to the screen incorrectly, the value in the ZZ2 byte

of x'40' is now used to recognize the first segment of a new page.

02390758 (351023)
• A problem with completely clearing currently displayed data when the last page was requested with =L

has been fixed. Data is now cleared completely before formatting the last page.

02512396 (407063)
• A problem that prevented device physical paging from working correctly on multiple screens, both from

the MFS menu and via PF keys, has been fixed.

02127948 02226814 (222064)
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JCL Support

Back to the list

• If a DD entry did not have a dataset name defined, it was excluded from the analysis when the job was
restarted using the auto-adjust option. This sometimes led to the job restarting at the wrong step. This
fault has been corrected.

02349857 (304005)
• A problem that caused incorrect symbols to be passed to a procedure when a DD override was applied

to a procedure step prior to the last step in the procedure has been corrected.

02457317 (389036)
• When listing catalog entries using the TSO command LISTCAT, the LRECL value was truncated to 4

digits and the high order value was not displayed. This has been corrected and the LRECL value is not
displayed using 5 digits.

02331981 (296001)
• To fix a problem that sometimes occurred when either the IMS MPR process shut down or when a CICS

SSTM region shut down and ES_SSTM_JOB_FLUSH_ACTIVE=Y,  the lex files for the SSTM job are
now removed.

02322067 (285165)
• An error that occurred when using FREE to free a dynamically allocated new GDS has been corrected.

02424185 (363221)
• A problem with the TSO LISTCAT command that caused it to display datasets with similar names to

those requested but that were outside the scope of the entry specified has been corrected.

02532129 (415117)
• A fault that caused a new GDG version to be incorrectly removed at the end of the step that created it

has been corrected.

02344573 02342424 02354398 (301037)
• The JCL File Handler has been updated such that when SRRCMIT or SRRBACK is called, all XA

modules associated with the current unit of work are notified. The last module referenced by a SWITCH
TO call is notified last so that the focus of the next SQL statement is the same module as before the
commit or rollback.

02552872 (442022)
• A problem that resulted in the failure to load MFJDBFH_CHECK_FILE_EXIST when viewing spool files

has been corrected.

02472170 (395102)
• Do not delete the JESYSMSG using the ESMAC/ESCWA interface for a job that is currently active. To

do so could result in job failures. If the SSTM job cannot be set up for a new process, error messages
are written to the console.log file indicating the reason, for example, the JES000041E and JES000018E
messages.

02363373 (313022)
• An error that caused the CICS spool process to abend when no CICS SSTM job was defined has been

corrected. Instead of an abend, an error message is issued in the console.log file indicating that the
spool file could not be added to the job because the SSTM job does not exist.

02186416 (220036)
• An incorrect error reported when using mfcatxml with the environment variable ES_SERVER set has

been removed.

02455029 (395082)
• If a DD card specified a UNIT value that was interpreted as a tape volume, that value incorrectly

overwrote the value for the SPACE units. This has been fixed.

02330375 (294011)
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• The FTP issue that sometimes occurred while performing a GET to a GDG dataset has been fixed.

02298846 (286031)
• The public catalog API has been updated to provide information about the GDG bias whether rolled in

or rolled out.

00425417 (411100)
• COND=EVEN behavior has been updated to work correctly when it is placed along with another return

code test.

02413227 (364100)
• The START operation on a dummy dataset was not returning FS=23, which is required to emulate

mainframe behavior. This has been fixed.

02261850 (258069)
• The mvscatpb function now correctly updates the SPACE-EXTENT-UNITS field of a dataset in the

catalog.

02429430 (372030)
• An issue with the MFFTP MPUT command caused it to search beyond the scope of the LCD DSname.

This has been corrected.

02333250 (296003)
• A problem that caused datasets to be locked exclusively when a job was restarted has been corrected.

02343791 (301057)
• A problem that prevented spool housekeeping from removing orphan job spool entries from the catalog

when it removed the JESYSMSG of that particular job has been fixed.

(393056)
• MFJAMS LISTCAT of a nonexistent dataset now returns condition code 4.

02478830 (393163)
• MFFTP now honors the SENDSITE command to emulate mainframe behavior using two new

environment variables: MFFTP_SENDSITE=Y|N (default is N) and MFFTP_QUOTE_SITE=Y|N (default
is Y). A SITE command is issued before a PUT or an MPUT command when  MFFTP_SENDSITE is set
to Y. A quote subcommand is always prepended to the site command unless MFFTP_QUOTE_SITE
is set to N. Linux only.

02191751 (221079)
• The %PCDSN extension syntax checking has been fixed so that an invalid catalog entry is not passed

through the JCL.

(326003)
• Dynamic System Symbols, such as &LDATE or &HHMMSS are now resolved when a JCL job is parsed.

02379833 (351055)
• An RTS 173 error that occurred on region shutdown in the printer exit process when no datasets had

been printed has been corrected.

02382404 02392374 (351034)
• MVSCATPB, the public catalog API, now returns the pc-dsn of a PO; however, that value might be

empty if one has not been assigned.

02436618 (382024)
• A problem that caused the value of SYSUT2 LRECL to be incorrect when copying from SYSUT1 in

IEBGENER/ICEGENER has been corrected.

02422566 (372032)
• The REN (RENAME) command was not recognized by IKJEFT01. This has been corrected.

02529686 (413035)
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• To avoid an MFFTP error, execute SAF authority checks against permanent datasets with the resolved
dataset name, and not against temporary datasets.

02423925 (363236)
• MFFTP now supports DDNAME.

02265813 (264046)
• Spool housekeeping now returns COND code 4, when the bulk delete operation fails with an FS=23,

record not found.

02478798 (399068)
• MFFTP now provides the local PC filename to the user exit instead of the temporary EOL file that was

used in the file transfer.

02512749 (405100)
• You can now pass more JOB information to the MFFTPXIT user exit, including job name, job number,

step name, step number, proc name, and proc number.

02386513 (340016)
• MFJAMS now correctly updates the SPACE attributes of each VSAM component in the catalog.

02434035 (379009)
• The MERGESPL.jcl file is now correctly located in the cpylib folder specified in the documentation.

(264034)
• A problem that prevented the altered disposition of a dataset from being reported when using UCC11

settings and restarting a job has been fixed.

02394363 (350045)
• A display statement in a CICS program sometimes encountered a problem when the process

terminated, potentially leaving an orphaned lock in the region. This has been resolved.

02554567 02554929 02562916 02574430 (451017)
• A problem with the REPRO of a VSAM dataset using the PATH to the alternate index has been fixed.

(10367)
• Informational messages that show the library from which a PROC or an INCLUDE group was loaded

are now written to the job log.

02354463 (304076)
• An EXPDT entry consisting of a year and 0 (zero) days is now accepted, and an informational message

issued (JCLCM0644I).

02074959 02558534 (183053)
• An issue with nested IF conditions not being correctly evaluated within an IF ABEND condition has been

resolved.

02456500 (386115)
• A problem that resulted in limiting the deletion of spool records via the ESCWA interface to only one has

been corrected.

(414167)
• A problem that caused the expect next GDS version to be out of sync with the actual version has been

fixed by improving GDS tracking. The listing of a GDG Base using the IDCAMS LISTCAT command with
the ALL option has been enhanced to show the rolled-in GDS, but not showing associations until the
GDG has been used in a job following the update).

02207067 (246045)
• To ensure that the DCB parameter is honored, do not copy the LRECL from DATACLAS if the dataset is

allocated using DCB=MODEL in the DD statement. 

02352955 (308001)
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• A problem that caused the create date/time of a spool file to be erroneously initialized when it was
updated using mfjctlbp has been corrected.

02394543 (351038)
• During a job restart, cataloged datasets that had not yet reached their expiration date were not deleted

properly. These are now deleted without any errors.

02503936 (401156)
• A problem that caused an incorrect return code to be set for an S422 abend when the job card specified

JOBRC=LASTRC has been fixed.

02454664 (392024)
• A new environment variable, ES_IEBGEN_TO_ICEGEN, has been added to enable VSAM copy using

MFGENER.

02469299 (393078)

Mainframe Access

Back to the list

• The MFMON2 command-line utility would throw an exception when it was unable to delete a temporary
file. This has been fixed.

02515298 (411041)
• The strupr() function was occasionally abending when the text to be folded was in the last allocated

page. This has been fixed.

(468028)
• When downloading job output that had a single or multiple blanks for a record, this could result in the

MFA Server abending. This has been fixed.

(407110)
• Syncmon2 now supports 10 character Panvalet member names.

02301547 (301002)

Micro Focus Batch Scheduler Integration

Back to the list

• Control-M : %%SET expression containing %%BLANK(nn) was causing blank character(s) to be
incorrectly suppressed. This has been fixed.

02476823 (395144)
• An issue in mfbsijcl related to Control-M LIBSYM/GLOBAL has been corrected.

02519366 (405218)
• The handling of a Control-M symbol file (GLOBAL/LIBSYM) containing an incorrect end-of-file delimiter

was incorrect. This has been fixed.

02476611 (393144)
• The mfbsijcl utility has been updated to detect lost connections to redis, and then reconnect.

02319798 02537263 (313011)
• The mfbsijcl and mfbsiemx utilities have been updated to detect lost connections to redis, and then

reconnect.

02537263 (441005)
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• In previous versions of Enterprise Developer and Enterprise Server, when the Control-M AutoEdit
functon %%MINUS was used, the numeric result value had the same number of digits as Operand
length.  For example:

       //* %%SET %%MIN3    = 005    
       //* %%SET %%MIN3_R  = %%MIN3 %%MINUS 3

sets MIN3_R to 002.

Starting in this release, you can obtain the a value of 2 for MIN3_R by specifying the %%MINUS=CTM
parameter in mfbsi.cfg. This ensures compatibility with Control-M z/OS.

Note: To stay compatible with previous versions of Enterprise Developer and Enterprise Server, do
not specify the %%MINUS=CTM parameter, or do specify %%MINUS=MF.

02524163 (411121)

Micro Focus Common Client

Back to the list

• Programs using the Micro Focus Common Client (MFCC) component, such as COBOL applications
invoking a Web Service proxy created by the Interface Mapping Toolkit (IMTK), can now be built as
single-threaded applications on Linux and UNIX. They no longer need to be executed under the multi-
threaded COBOL runtime. Note: Multi-threaded applications are still supported.

(306131)
• The Micro Focus Common Client now adds Accept and Origin headers with default values to HTTP

requests if the invoking program has not set its own values for those headers. This improves
interoperability with some Web services.

Note: This affects COBOL Web service client proxy programs, CICS Web Interface clients, and
CICS Web Services clients.

(104096)

Micro Focus Cryptographic Library

Back to the list

• The version of OpenSSL provided with the product has been updated to 1.1.1t.

(407184)

Micro Focus Directory Server

Back to the list

• MFDS stopped when supplied with the incorrect mfServer property when updating an enterprise server
region. This has been fixed.

02547102 (442003)
• The casstart /s option incorrectly copied the start-type parameter. This has been fixed

02250159 (244185)
• An issue that sometimes caused MFDS to crash when starting multiple enterprise server regions

simultaneously has been fixed.

02310876 02409262 (286081)
• In ESCWA, modifications have been made to MQ Listeners, JES Initiators, JES Printers, and IMS

MPRs so that they persist across MFDS restarts.

02341059 (297067)
• Micro Focus Directory Server internal session identifiers have been increased in size and complexity to

reduce vulnerability to attack.
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02365249 (344004)
• Starting or stopping an enterprise server region using ESCWA or the MFDS UI intermittently terminated

the process. This has been fixed.

(415049)
• Modifying or deleting an enterprise server region's MFRHBINP Request Handler via the ESCWA user

interface or API is no longer allowed.

02525461 (413117)
• The Validate feature on an enterprise server region running on a UNIX platform sometimes incorrectly

flagged a valid Web Services and J2EE listener as not startable.

02370910 (318020)
• Enterprise server region start-up performance was slow when a large number of regions were specified

on a Micro Focus Directory Server with a large number of values stored in the vault facility. This has
been corrected.

(394122)
• If the MFDS process could not access the TCP port it was configured to use, it failed to start and

emitted the error message HS0001S HTTP server failed to initialize, rc=6:
CCITCP-0006E An invalid server or machine name was presented to CCITCP. It now
fails with the message HS0001S HTTP server failed to initialize, rc=57:
CCITCP-0057E Insufficient permission to complete an operation.

(388038)
• If the MFDS process could not access the TCP port it was configured to use, it failed to start and

emitted the error message HS0001S HTTP server failed to initialize, rc=6:
CCITCP-0006E An invalid server or machine name was presented to CCITCP. It now
fails with the message HS0001S HTTP server failed to initialize, rc=57:
CCITCP-0057E Insufficient permission to complete an operation

02433110 (380037)
• Some audit events output when setting the Create Audit Events option for the MFDS process using the

MFDS Web interface were not being output when using ESCWA to change the same configuration. This
has been corrected.

02412285 (365078)
• MF Directory Server Enterprise Server Administration HTML Web interface was accepting UNC paths

as input values for some import and export operations. This has been fixed.

02423785 (369017)

Micro Focus License Administration

Back to the list

• Micro Focus License Administration now displays the licenses for the same product and serial number
but with a different expiry date on separate lines.

(365148)
• Some libraries have been updated to fix current known vulnerabilities.

(295042) (295068) (309006)
• The SafeNet server list can now be used as expected.

02341760 (259135)

PL/I Support

Back to the list
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• A problem with CICS API calls on 64 Bit Solaris has been resolved.

(204210)
• UNSPEC('any-literal') returned an incorrect result when -bitsltr was in effect. This has been

corrected.

02332714 (297013)
• A problem that caused the compiler to abort on a DFT RANGE(*) without attributes has been fixed.

02134010 (198020)
• A problem that occurred when the first operand of the PRECISION built-in was type PICTURE has been

fixed.

02386647 (352016)
• All variable names in evaluations are now rendered in upper case according to the existing style.

(405076)
• Every version of Ubuntu starting with 10.10 comes with a setting that prevents an application from using

ptrace to attach to another process. This prevents the PL/I debugger from attaching to user
processes, and therefore debugging fails. To prevent this problem, disable the offending setting as
follows before installing:

1. Using any text editor, open the /proc/sys/kernel/yama/ptrace_scope file.
2. Set pctrace=0.

(402010)
• A problem that occurred when using a JCL User Exit written in COBOL that called PL/I subroutines

prevented the FINISH condition from being correctly driven when multiple jobstreams ended with STOP
and SIGNAL ERROR. This has been corrected. 

02426916 (371002)
• PL/I triggered a FIXEDOVERFLOW when a FIXED DECIMAL target was assigned for the ADD,

SUBTRACT, or DIVIDE built-in functions that specified an even precision for the optional third
parameter. This behavior did not match mainframe behavior, and has now been fixed. 

02163371 (306065)
• The open and close parenthesis were erroneously included in the start/end column information for a

variable reference when used within and EXEC CICS statement. This has been corrected.

(405098)
• The PL/I macro preprocessor erroneously merged keywords split by a new-line character. This has

been fixed.

02382436 (331016)
• A problem with an incorrect result for the DAYS built-in function with -bifprec 31 on Solaris and AIX

is now fixed.

(338010)
• A problem that caused an abort on comma-separated assignments with concatenated string constants

has been fixed.

02040800 (167025)
• A problem that occurred when array of fixed bin unsigned (8) was passed as an argument

to entry has been fixed.

02267392 (259072)
• A limitation with Restricted Expression Evaluation has been resolved.

00368484 (13137)
• A problem calculating the result length of the STRING built-in when applied to non-connected storage

has been fixed.

02514231 (406150)
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• An erroneous diagnostic, MFPLI00349E Invalid Defined Overlay, has been corrected when
CHAR type alignment attributes differ.

02522533 (410043)
• A problem that caused the Open PL/I compiler to misdiagnose missing arguments in a CALL statement

when OPTIONS(VARIABLE) was not specified on the ENTRY declaration has been fixed.

02498133 (402105)
• A problem that prevented the PLI EDIT built-in function from working with EDCDIC data has been fixed.

02413874 (364086)
• A problem with a keyword following a string literal with no space between, e.g., dcl y pic'99'def

c;, has been fixed.

(327006)
• The compiler cross-reference (-xref) listing now ensures alignment f line/fileid, nesting, and source

margins in the listing file. 

02159460 (285036)
• A problem with using a function call without parentheses as an array index has been corrected.

02053467 (167108)
• When the ROUND built-in function is given a negative scale factor, MFPLI00554W (now W-level) is

issued and a zero-scale factor is no longer supplied by the compiler. The negative scale produces the
intended result.

02380701 (350017)
• A problem with DEFAULT RANGE (*) BUILTIN overriding previous DEFAULT RANGE (*) type

attributes for non-built-ins has been fixed.

(400017)
• A problem that caused the DB2 ECM to generate little/big endian conversion loops for each element of

an indicator array has been fixed to only convert it once for the entire array.

02373551 (321012)
• The PL/I PLIDUMP report has been extended to support decorated external symbols and variable

names when running under Windows. The variable name, type, and value (if known) are now displayed
for these decorated external types.  Note:  If the external variable is not currently being used or
accessed in the program that generates the PLIDUMP report, its type and value is not identified as that
information is not not present in the program's PDB file. The error message displayed for a variable in
this category has been amended to suggest that this is the issue.

02557839 (441078)
• The QUICKSORT and QUICKSORTX built-in subroutines are now supported.

00368505 (28200)
• Open PL/1 now supports the MIN and MAX built-ins with array arguments. In addition, the maximum

number to arguments allowed is 64.

02040835 (167026)
• Open-PLI now accepts ENDF as an abbreviation for the ENDFILE condition.

02048350 (167074)
• The following compiler options now imply –nolaxif: -cics, -sql, -dli, -mvs, and -ims 

(402054)
• A problem that occurred when trying to read an ASCII LSEQ dataset using the SYSIN FILE opened with

an explicit OPEN, in a program compiled with -ebcdic, prevented the input records from being
automatically translated to EBCDIC. This has been fixed.

02388783 (346010)
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• A problem that stopped the Open PL/I PLISAXA parser from parsing when the
UNKNOWN_CONTENT_REFERENCE event was driven, and which then triggered an EXECEPTION
event with a code of 26 has been corrected.

02552959 (441034)
• When attempting to do a REWRITE of a VSAM record using a BIGENDIAN CHAR VARYING scalar as

the argument to the FROM option, a RECORD condition was sometimes erroneously raised. This has
been corrected.

02544322 (429073)
• An implicit open of a CTLASA dataset targeted as a SYSOUT in the JCL and with a RECFM of V failed

with an UNDEFINEDFILE condition when the implicit open immediately followed an open/close cycle.
This has been fixed.

02503905 (401159)
• A problem that caused an ERROR condition when attempting to do a REWRITE to a fixed-length file

from a CHAR VARYING even though the length of the CHAR VARYING was exactly the same as a the
fixed-length record needed when the program was compiled with -bigendian has been fixed.

(327004)
• The B format specification in a PL/I PICTURE variable was not always honored properly. This has been

corrected.

02397067 (351067)
• An erroneous severe MFPLI00092S diagnostic related to a missing locator has been fixed.

00368488 (415071)
• PL/I BiFs JSONPUTVALUE and JSONPUTMEMBER wrongfully adding structure-member closing tags.

This has been corrected.

02298471 (267008)
• The PL/I JSON built-in function sometimes returned an incorrect number for bytes processed. This has

been fixed.

02491557 (399091)
• The PL/I SUBSTR built-in was producing incorrect results. This has been fixed.

02338555 (297035)
• The PL/I JSONGETVALUE built-in function now correctly parses JSON escape characters.

02399600 (352078)
• The PL/I macro -tagmin option now covers both built-ins and procedures.

02310267 (284005)
• A problem with the PL/I compiler caused it to issue correct diagnostics on an uninstalled license and

when the licensing daemon was stopped. This has been corrected.

02409479 (386043)
• The PL/I xmlcontent attribute is now supported.

02292363 (260198)
• Diagnostics for the CONTROLLED argument has been improved.

02130963 (195071)
• The incorrect result returned by the LENGTH built-in function when used with the TRIM built-in has

been fixed. For example:

pic1 = LENGTH(TRIM(string1)) ;

Where pic1 is any PICTURED variable, and string1 is any CHAR or CHAR VARYING string.

02291604 (264004)
• A problem that occurred when passing a CHAR(*) VAR BIGENDIAN argument to an ENTRY without

parameter descriptors has been fixed.
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02393040 (350031)
• A problem at compile time with evaluating expressions involving the LENGTH and MAXLENGTH built-in

functions has been fixed.

02453457 02453465 02453476 02453510 (385057)
• A problem concatenating based bit strings has been fixed.

02384231 (331026)
• A problem with the HEX built-in when used in conjunction with the two-argument form of the CHAR

built-in has been fixed.

02371250 (314032)
• A message was added to PLIDUMP to print {cond static external} for CONDITION declarations

in the locals section rather than throwing the following errors: 
MFCWD06102E EXTERNAL variable not found in map. MFCWD09121E Invalid type to fetch.

(393106)
• The PL/I documentation has been updated to include the -laxother and -nolaxother compiler

options.

(27357)
• The MFP_RAISEERROR environment variable has been added to enable the direct raising of ERROR

when STRINGRANGE or SUBSCRIPTRANGE would otherwise be triggered. Valid values are
STRINGRANGE;SUBSCRIPTRANGE (for both), STRINGRANGE, and SUBSCRIPTRANGE.

00696776 (368012)
• The FIXEDOVERFLOW condition was sometimes raised erroneously when FIXED DECIMAL division

and dividing 0 by another number This has been resolved.

02430977 (372028)
• A problem that caused memory corruption in PL/I JSONPUTMEMBER() with a value containing double

quotes has been fixed.

02496895 (401074)
• A problem related to STRING pseudo-variable with PICTURED type has been fixed.

02062482 (180008)
• A problem with an IF/ELSE block not behaving as expected when the IF clause was not of type BIT(1)

has been fixed.

02459207 (390029)
• Previously, if an EDIT-directed output was specified with a B() format, an RTS Error 137 would be

generated if the length of the B() format item was less than the length of the underlying variable being
displayed.

02382223 (387115)
• The documentation for PL/I run-time messages and codes has been updated with new explanations

and error codes.

02423667 (364163)
• The PL/I EXEC preprocessor has been updated to allow comments containing DB2 optimization

guidelines.

02474554 (393114)
• A problem that caused the PL/I macro preprocessor to SIGSEGV on PARMSET evaluation has been

fixed.

02378658 (327002)
• A problem that caused the PL/I EXEC preprocessor to skip % statement parsing has been fixed.

02343270 (301024)
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• A PL/I member declaration was missing for DB2 SQL INSERT using arrays. This has been corrected.

02421921 (365182)
• A problem causing a MFPLI00465W: The expression is a duplicate of one found in a

previous WHEN clause warning to be erroneously generated has been fixed.

02425404 (370011)
• A problem with named constants of type BIT resulting in a conversion error during initialization has been

fixed.

02425272 (365219)
• A problem that caused the PL/I macro preprocessor to produce a SIGSEGV on PARMSET evaluation

has been fixed.

02359139 (308041)
• The PL/I COMMENT() built-in function incorrectly handled strings spanning over multiple lines. This has

been fixed.

02490439 (399077)
• A problem that caused the PL/I macro preprocessor to misalign source output has been fixed.

02366044 (306123)
• PL/I nested macro procedure in a built-in now provides correct %SDEBUG and %RDEBUG tags.

02311393 (286018)

REXX Support

Back to the list

• MVSVAR('SYMDEF','SYSTEMA') now returns the value of SYSTEMA if it has been specified in an
IEASYSxx member of SYS1.PARMLIB

02398875 (350090)
• Submitting JCL that runs REXX code that resulted in a fault had the potential to cause the failing REXX

program to become locked in the REXX program cache. This has been fixed.

02387862 (351002)

Run-time System

Back to the list

• The memory associated with a dynamic length item declared in local-storage was not released when
the program instance exited, which led to memory leakage. This has been fixed.

(443004)
• The Run-time System now produces an RTS error if the Profiler attempts to output an .ipf file in a

read-only directory.

(407092)
• An issue in the native Run-Time System's clean-up logic sometimes resulted in a crash when a .NET

AppDomain running a .NET COBOL program was unloaded. This has now been fixed.

02259505 (301047)
• Previously, in some ES region configurations, enabling CTF tracing for RTS API events could result in

very large CTF trace log files, and cause an ES region to take a very long time to start. This has now
been fixed.

02320601 02497148 (403104)
• Programs using the public SPOOL API - MVSSPLPB - failed when run outside of an enterprise server

region. This is now fixed.

02328509 (291012)
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• If a debugger process was killed on Linux (using kill -9 <pid>) then the debugger process could hang in
certain circumstances. This has now been resolved.

(387100)
• If multiple asynchronous run-units are created, with CBL_EXEC_RUN_UNIT on UNIX/Linux, then it was

possible for some of them to be left marked as "<defunct>" in the OS process table. This has now been
resolved.

02537643 (422001)
• The CBL_CULL_RUN_UNITS API now more closely complies with the documented behavior on UNIX.

It now clears all asynchronous run-units, when multiple run-units have terminated, and does not clear
child processes that are not run-units.

(439075)
• The event priority of a CTF API entry is set to a default value of 0 when CBL_EXIT_PROC is called with

a function code that does not expect a priority or provides an invalid one.

(380019)
• The LE370 module CEE3DLY will now be found when compiling and running a program on UNIX

platforms.

(375014)

Setup Issues (UNIX)

Back to the list

• The RPM installer for Enterprise Developer for Eclipse was missing some of the required components.
This has been corrected.

02366247 (306126)
• You can use the environment variable TMPDIR when installing the product. See Visual COBOL

Development Hub Installation Options in your product Help for more information.

(252002)

SQL: COBSQL

Back to the list

• A problem with COBSQL that prevented it from handling the FETCH and EBCDIC conversion of more
than 100K rows has been fixed.

02236464 (260248)
• COBSQL has ben updated to handle ENTRY statements broken into multiple lines.

02417156 (367003)
• COBSQL has been modified to handle inline comments in EXEC SQL statements when using the

SYBASE precompiler.

(285007)
• COBSQL has been updated for SYBASE such that it no longer inserts a period when an EXEC SQL

statement is coded inside of an IF block. 

01886033 (125015)
• COBSQL has been updated to handle EBCDIC conversion of group variables used in INSERT

statements.

02316688 02316681 (285067)
• The COBSQL precompiler has been updated to correctly convert redefined EBCDIC variables when

present.

02421843 (364169), 02444639 (382084), 02453885 (385123), 02426534 (385109)
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• COBSQL has been modified to handle EBCDIC conversion of group variables.

02316681 (288015)
• COBSQL has ben updated to handle inline comments inside DECLARE blocks when Informix is used.

02380790 (348020)
•  The COBSQL preprocessor has been updated to support the ALPHA-LIT-CONT directive.

02544092 (430025)

SQL: HCO for DB2 LUW

Back to the list

• The DB2 ECM now correctly sets the length of the PIC G host variables before CHARSET conversion.

(424053)
• An RTS 114 error sometimes occurred when SQLCODE was set to 0 (zero) and an SQL program built

as 64-bit called either DSNTIAR or DSNTIAC. This has been corrected.

02304281 (393071)
• A problem that caused DB2 database values to return ASCII values in EBCDIC mode when using the

DB2 ECM, the dialect"ENTCOBOL" directive, and a customize character set translation, has been
resolved.

(425023)

SQL: HCO for PostgreSQL

Back to the list

• HCOPG returned unexpected values for TIMESTAMP_ISO statements. This has been corrected.

02513681 (406103)
• A problem that occurred when using the CURRENT SQLID in SELECT INTO statement with

SQL(DIALECT=MAINFRAME) has been fixed.

02356934 (306026)

SQL: HCO for SQL Server

Back to the list

• HCOSS returned unexpected values for TIMESTAMP_ISO statements. This has been corrected.

02513681 (406103)
• When the DATE and TIME directives were used with HCOSS for PostgreSQL, the incorrect format was

applied to datetime literals. The correct corresponding format is now applied.

(397080)
• OpenESQL has been updated to return SQLWARN4=space with DIALECT=MAINFRAME and

SQLCODE=-811.

02360026 (308064)
• A problem that caused HCOSS to return a space in SQLWARN0 when no other SQLWARN field

contained a W has been fixed.

02397838 (351070)
• A problem compiling a COBOL SQL program with multiple fetch statements using WITH ROWSET

POSITIONING has been fixed.

02340840 (297057)
• A problem with passing numeric or blank values for unsupported parameters to the HCOSS DSN bind

utility caused a DSN syntax error. This has been resolved.
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02338931 (296093)
• A problem with inserting a DEFAULT value as the only item in the list of an INSERT statement with

SQL(DIALECT=MAINFRAME) has been fixed.

02354547 (303098)
• When using an EXEC SQL DECLARE host-variable VARIABLE FOR BIT DATA statement you can now

specify multiple host variables as a comma-separated list.  If you use multiple DECLARE host-variable
VARIABLE FOR BIT DATA statements in one EXEC SQL block, a compile error now occurs.

02167287 (203217)
• ErrRow options have been added to the command-line version of the HCOSS Transfer Data tool.

02523081 (410056)
• A problem that sometimes occurred then running the HCOSS mfdatatransferctlr command to

transfer data from DB2 to SQL Server has been fixed.

02473761 (393118)

SQL: Mainframe Batch Database Utilities (MBDT)

Back to the list

• A problem that occurred when loading a data record into a specific partition of a table in DB2 LUW
where the partition column was of the DECIMAL data type has been fixed.

02236304 02391344 (264096)
• A problem outputting a cataloged SYSPRINT in LSEQ  format from SQLTP2 has been fixed.

02493612 (405166)
• MINVALUE and MAXVALUE in the partition definition of a table in DB2 LUW are now supported.

02552457 (442029)
• A performance issue that occurred when executing a large number of SELECT statements (>2000)

using SQLTP2 has been fixed.

02452507 (387078)
• A problem with tokenizing SELECT and FROM  when they were the last word of a line has been fixed.

02369123 (313049)
• A problem that caused COND Code=004 to be returned when no rows were unloaded by SQLTUL or

DSNTIAUL has been fixed.

02564044 (448064)
• A problem that prevented the full description of SQL Warnings and Errors from appearing in the

SYSPRINT generated by SQLTUL has been fixed.

02368699 (314014)
• A problem that occurred when using empty string '' in the projection list of SELECT statement with

SQLTUL has been fixed.

02333999 (296042)
• A problem with using SQLUTB LOAD to print SYSPRINT for concatenated SYSIN that has multiple

LOAD commands has been fixed.

02457219 (385098)
• A problem loading SQTUL into Enterprise Server for execution on Linux caused an RTS114 error. This

has been fixed.

02430243 (393022)
• A problem with defining DCB with RECFM only for SYSREC when using SQLTUL UNLOAD has been

fixed.

02430243 (394076)
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• A problem that occurred when using POSITION(*) and POSITION(*+n) in the field specifications for
SQLUTB LOAD has been fixed.

02355299 02456205 (307056)
• A problem that occasionally caused an ABEND by SYSPRINT, FCD3 STATUS: 9 when executing the

SQLUTB utility to unload/reload DB2 LUW tables multiple times in one JCL job has been fixed.

02432703 (372071)
• A problem unloading data from empty views (or tables) that contained varchar/varbinary columns using

SQKUTB has been fixed.

02500000 (405182)
• A problem loading the implied decimal data into tables with SQLUTB has been fixed.

02361847 (310040)
• A problem with using SQLTUL to unload CLOB and BLOB data into a record with other fields when the

LOGFILE parameter was not specified has been fixed.

02463342 (389044)
• A problem that occurred when setting null values to 0x00 bytes in the unloaded data sets generated by

SQLTUL/DSNTIAUL has been fixed.

02348857 (372004)
• A problem with executing SELECT statements that had a large number of rows with SQLTUL has been

fixed.  

02398804 (363147)
• A problem using a large-size SQL statement (up to 64K) as SYSIN input for SQLTUL has been

corrected.

02335290 02346228 (272013)
• The DEFAULTIF option in DSNUTILB LOAD and SQLUTB LOAD is now supported when the condition

parameter is a character-string.

02456269 (386112)

SQL: OpenESQL

Back to the list

• A problem that caused erroneous memory usage in the OpenESQL run time has been fixed.

02321779 (293023)
• A problem that prevented parameters in the ADO UNBIND CONNECTION statement from being

replaced has been fixed.

(406004)
• A problem that prevented a temporary table from being created has been fixed.

02494026 (401152)
• HCOSS date expressions missing the date part compiled incorrectly. This has been fixed.

02501717 (407018)
• A problem that prevented HCO for SQL Server and PostgreSQL from applying the expected values

when set statements contained three or more host variables has been fixed.

02506484 (405077)
• The .NET 6 ODBC Nuget package was missing some dependencies. These are now included.

02474422 (395110)
• DSNREXX now handles SQLIND in SQLDA correctly when a NULL record is returned.

02540551 (419034)
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• DSNREXX now successfully executes SQL statements larger than 512 bytes.

02442341 (389037)
• The column length of a VARCHAR type column was returned incorrectly when the SQL statement was

being prepared dynamically. This has been corrected.

02503856 (405091)
• A problem that prevented database locks from being released at the end of an DSNALI transaction

when using switch modules that use OpenESQL has been fixed.

02307521 (296031)
• A problem that occurred when specifying the SQL(CLOSE_ON_ROLLBACK=NO) directive caused SQL

Server to automatically close a cursor after a rollback statement has been corrected.  The cursor is now
defined as a fast-forward cursor instead of a fire-hose cursor.

(401104)
• A problem with the ODBC ECM that produced a subscript-out-of-range error when using a host variable

with a leading FILLER item before a data item in an SQL statement has been fixed.

02334866 (312064)
• When run under Enterprise Server with an XA connection, HCOSS stored procedures were being

called without the DIALECT=MAINFRAME directive being set. This has been resolved.

02318095 (286138)
• A problem that sometimes occurred when compiling DBCS code in SJIS locale for embedded SQL

applications has been fixed.

02349559 (301080)

SQL Option for DB2

Back to the list

• An issue with the XDB ODBC Driver failing to get output arguments returned from a stored procedure
due to the setting of null indicators has been resolved.

02420241 (377058)
• An issue involving nested scalar/aggregate functions operating on a view containing a union of other

queries resulted in query common space being exhausted. This has been resolved.

02434830 (375074)
• An invalid return of X004 Number value overflow has been resolved when using Java to send a

BigDecimal value of zero into a DECIMAL(1,0) value.

02444253 (380071)
• A problem that caused the DB2 TIMESTAMPDIFF function to give incorrect results when setting XDB

Server to DB2 V10 or DB2 V11 has been fixed.

02260541 (253025)
• A server thread violation on a union query containing the RID scalar has been resolved.

(5425)
• The XDB Migrate utility has been enhanced to allow for the substitution of object qualifiers in the

CREATE VIEW source retrieved from the STATEMENT CLOB in a source location SYSIBM.SYSVIEWS
table.

02418490 (365153)
• A problem with COMMIT WORK statements performed dynamically by XTEP2 that caused the

COMMIT query descriptor in the client side communication layer to leak has been fixed.

02310413 (285128)
• Local XDB engines now allow a single expression within an INSERT VALUES clause that is not

surrounded by parentheses.
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02333579 (296112)
• The BOPT40N utility now dumps the usage information to standard out when invoked with the -h option.

02346831 (297134)

XML Support

Back to the list

• The XML runtime now performs better when reading a large XML file.

02526445 (417029)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Defect number (in parentheses).

• (295041)
• 02508043 (407049)
• 02479358 (393153)
• 02504425 (424001)
• 01901711 (127012)
• 02287394 (258209)
• 02558536 (447020)
• 02190101 (363024)
• (381007)
• (384016)
• 02450685 (386098)
• 02423113 (364179)
• 02439474 (382038)
• 02453576 (385060)
• 00373758 (448044)
• 02500115 (406011)
• (402012)
• 02458038 (387132)
• 02544746 (425075)
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Unsupported or Deprecated Functionality
This section includes information about features or functionality that are not supported.

• The SafeNet Sentinel licensing system has been deprecated and will be not available in this product
starting with the next major release - release 10.0. The SafeNet Sentinel licenses will not be supported
after release 9.0. You can only use AutoPass licenses starting with release 10.0.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
However, it is not necessary to switch to AutoPass licenses unless you are adopting release 10.0.
Contact Micro Focus Customer Care for further information.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.

Unsupported or Deprecated Functionality | 79



Additional Software Requirements
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (Windows) on the
Product Documentation pages on Micro Focus Customer Care.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (UNIX) on the
Product Documentation pages on Micro Focus Customer Care.
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Installation

Installing Enterprise Developer for Eclipse (Windows)

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

On Windows

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.

The disk space requirements for Windows are, approximately:

Enterprise Developer

3.5GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Enterprise Developer setup file. This includes the space
needed to cache information locally so that you can modify the installation without the original source
media.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Also note the following:

• A 64-bit Windows is required. 32-bit Windows is not supported. See Installation in Known Issues and
Restrictions.
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You can produce both 64-bit and 32-bit applications with Enterprise Developer on 64-bit operating
systems.

• The Server Core form of Windows Server 2019 is not supported.

Software requirements

Note: This product includes OpenSSL version 3.0.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Requirements for the setup file

• A 64-bit Windows is required. 32-bit Windows is not supported. See Installation in Known Issues and
Restrictions.

• The setup file installs Enterprise Developer and the 64-bit version of Eclipse 4.24 (2022-06).

Enterprise Developer only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to
create both 32-bit and 64-bit applications.

• The setup file installs Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot.
• The setup file also installs Microsoft's Visual C++ 2012 and 2015-2022 Redistributables.

Requirements for running the product on Windows

• Java 11 (64-bit) or later is required to run the Eclipse IDE. The recommended version is Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Windows, the installer automatically installs Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Linux, you need to install Java before you install this
product. You can download Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web
site and unpack the archive anywhere on your machine.

• Enterprise Developer requires a 64-bit Java installation to run a 64-bit Eclipse.
• Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL

development environment depend on certain files that Microsoft distributes in the following package: the
Windows SDK package. See Microsoft Package Dependencies for a full list of actions and operations
that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblmx`s command line utility post-installation to manage this; see Managing the Microsoft
Build Tools and Windows SDK Packages for more information.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager

before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.
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2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Additional Software Requirements

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (Windows) on the
Product Documentation pages on Micro Focus Customer Care.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (UNIX) on the
Product Documentation pages on Micro Focus Customer Care.

Product Co-Existence

Note: The following applies to Windows only.

• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.

• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements

Before starting the installation you should consider the following:

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Various actions and operations within your COBOL development environment depend on certain
Microsoft files distributed in the following packages: the Windows SDK package and the Microsoft Build
Tools package. By default, a standard product installation downloads and installs these. Refer to
Microsoft Package Dependencies to see if these packages are required. If you do not plan to use your
development tool in a way that will depend on any of these packages, you can run a non-standard
installation, which will skip their download and installation, thus saving disk space and time taken for
installation. Refer to Advanced Installation Tasks for details on the available installation options.

On UNIX

System Requirements for Micro Focus Enterprise Developer UNIX Components

Hardware Requirements

The disk space requirements for Micro Focus Enterprise Developer UNIX Components are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

POWER
running AIX

Micro Focus 1.1 GB 4.40 GB 2.20 GB 41 MB
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

System Z
running Red
Hat Linux

Micro Focus 630 MB 2.52 GB 1.26 GB 39 MB

x86-64
running Red
Hat Linux

Micro Focus 1.17 GB 4.66 GB 2.33 GB 50 MB

Red Hat for
Docker

Micro Focus 809 MB 3.24 GB 1.62 GB 50 MB

x64 running
Amazon Linux
2

Micro Focus 804 MB 3.22 GB 1.61 GB 50 MB

Amazon for
Docker

Micro Focus 803 MB 3.21 GB 1.61 GB 50 MB

SPARC
running
Solaris

Micro Focus 877 MB 3.51 GB 1.75 GB 42 MB

System Z
running SUSE
SLES

Micro Focus 585 MB 2.34 GB 1.17 GB 39 MB

x64 running
SUSE SLES

Micro Focus 865 MB 3.46 GB 1.73 GB 50 MB

x64 running
Ubuntu

Micro Focus 834 MB 3.34 GB 1.67 GB 50 MB

SUSE for
Docker

Micro Focus 864 MB 3.46 GB 1.73 GB 50 MB

Ubuntu for
Docker

Micro Focus 864 MB 3.46 GB 1.73 GB 50 MB

x86-64
running Rocky
Linux

Micro Focus 1.17 GB 4.66 GB 2.33 GB 50 MB

Rocky Linux
for Docker

Micro Focus 809 MB 3.24 GB 1.62 GB 50 MB

x86-64
running
Oracle Linux -
Red Hat
Compatibility
Kernel

Micro Focus 1.17 GB 4.66 GB 2.33 GB 50 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.
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Software Requirements for Micro Focus Enterprise Developer UNIX Components

The following topic lists the software requirements for Micro Focus Enterprise Developer UNIX
Components.

• Software required by the setup file
• Libraries required by the setup file
• Software required to run the product
• Required environment variables
• License Manager requirements

Software required by the setup file

• The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
always installed by default. Use your UNIX/Linux installation media to install it.

• GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons 
true

Libraries required by the setup file

The following table lists the required libraries for Red Hat and SUSE Linux platforms. The setup file checks
that both the 32-bit and 64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

Library 32-bit
Librar

y
Name

64-bit
Library
Name

Platform

s390 SUSE
121

SUSE 151 Red Hat 6x Red Hat 7 Red Hat 8

glibc glibc-
*.i686

glibc-
*.x86_64

glibc-
*.s390

X X X

libgcc libgcc
-
*.i686

libgcc-
*.x86_64

libgcc-
*.s390

X X X

libstdc++ libstdc
++-
*.i686

libstdc++-
*.x86_64

libstdc++-
*.s390

X X X

glibc-locale glibc-
locale
-32bit

glibc-
locale-2

X X

glibc-devel glibc-
devel-
*.i686

glibc-
devel-
*.x86_64

glibc-
devel-
*.s390

X X X

elfutils-libelf elfutils
-
libelf.i

elfutils-
libelf.x86-
64

N/A X X X
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Library 32-bit
Librar

y
Name

64-bit
Library
Name

Platform

s390 SUSE
121

SUSE 151 Red Hat 6x Red Hat 7 Red Hat 8

386
or
elfutils
-
libelf.i
686

libelf-devel** elfutils
-
devel.
i386
or
elfutils
-
devel.
i686

elfutils-
devel.x86
-64

N/A X X X

libelf-devel** libelf-
devel-
32bit-
0.137
-8.19

libelf-
devel-0.1
37-8.19

N/A X X X

libelf1** libelf1
-32bit-
0.137
-8.19

libelf1-0.1
37-8.19

N/A X X

gcc2 gcc*.i
686

gcc*x86_
64

X X X X X X

cpp2 cpp*x86_
64

X X X

ld2 Binutil
s*.i68
6

Binutils*x
86_64

X X X X X X

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 1On SUSE 12 and 15, you can only install the 64-bit version of Enterprise Developer. The glibc-

locale-32bit library is still required by the SafeNet Sentinel licensed components.
• 2On Red Hat, these libraries are required to enable COBOL and PL/I to compile.
• * Additional libraries required to use the core_on_error run-time system variable. The gdb packages (for

the GNU Project Debugger) can be installed from the install media for your OS.
• ** Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

Software required to run the product

• Java 1.8 (64-bit) or later is required to run Micro Focus Enterprise Developer UNIX Components. The
recommended version is Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot. You can download
Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web site and unpack the archive
anywhere on your machine.
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Required environment variables

• To execute JVM COBOL code, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the
installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager

before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Installation on UNIX and Linux (Known Issues)

Installing on Linux

On Linux, the RPM installer for Enterprise Developer for Eclipse installs a 64-bit version of Java. When you
start the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not
be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux which
prevents you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:
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• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Enterprise Developer.

Installing on Ubuntu 10.10 and later

Every version of Ubuntu starting with 10.10 comes with a setting that prevents an application from using
ptrace to attach to another process. This prevents the PL/I debugger from attaching to user processes, and
therefore debugging fails. To prevent this problem, disable the offending setting as follows before installing
Enterprise Developer:

1. Using any text editor, open the /proc/sys/kernel/yama/ptrace_scope file.
2. Set pctrace=0.

For more information, see Debugging applications that run on Ubuntu (ptrace restriction).

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.
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Installing on Windows
Note:

• This version of the product is a full install.
• If you have an earlier version of Enterprise Developer installed on your machine, check Installing

as an Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Enterprise Developer:

1. Run the ede_90.exe file and follow the wizard instructions to complete the installation.

By default, this installs Enterprise Developer in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer folder and installs a full version of Eclipse 4.24 (2022-06) 64-bit, with the
Micro Focus plugins already installed, in the C:\Users\Public\Micro Focus\Product Name
\eclipse directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks.

Installing Micro Focus Enterprise Developer UNIX Components
Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_9.0_platform

2. Run the installer from the Process User ID login:

./setup_entdev_9.0_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

Note: On Ubuntu, the prompt for superuser password is not available. On this platform you must
either log in as root or use the sudo command to get root permissions before you run the installer.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

Enterprise Server System Administrator Process

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server processes
except the one for the Micro Focus Directory Server (MFDS). The Directory Server process (Enterprise
Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the Process
User ID which can affects the file access and creation.

You must supply the user ID at the command line - specify -EsadminID=[ ID ] as part of your
command.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh and follow the
onscreen instructions.
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SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_entdev_9.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass

• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing and licensing Micro Focus Rumba - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing into other instances of Eclipse - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing the Mainframe Components, - Mainframe Access Server, Application Workflow Manager into

IDz, z/Server - available in the product Help and on the Product Documentation pages on Micro Focus
Customer Care

• Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product
Documentation pages on Micro Focus Customer Care
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Click here to see this information on the Product Documentation pages on Micro Focus Customer Care.

On Windows

Installing as an Upgrade

• This release cannot be installed as an upgrade to an earlier release of Enterprise Developer. You must
uninstall the previous version before installing 9.0.

Enterprise Developer Installation Options

To see what parameters you can use, execute the following from the command line:

install-file /help

where install-file for the following products is as follows:

Enterprise Developer ede_90.exe

See the Examples section further in this topic for examples of some of the parameters you can use.

Directory considerations

• You must have read and write access for every directory accessed during the installation.
• You can override the default installation folder using the InstallFolder parameter.

• Installing creates a group of log files prefixed Micro_Focus_ in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:

/log drive:\path\LogFilename

Skipping installation of the Microsoft package dependencies

A standard installation downloads and installs the latest versions of the Microsoft Build Tools (for Visual
Studio 2017) and the Windows 10 SDK packages to their default locations. Using the following option, you
can skip installation of these packages, thus reducing the footprint and duration of the installation. See
Microsoft Package Dependencies to see if you can safely skip installing these packages.

ede_90.exe skipmstools=1 

Offline installations

An offline installation is one where the client running an install is not connected to the internet; the problem
this presents is that the installer cannot download and install certain file and package dependencies; see
Microsoft Package Dependencies. In such circumstances, an administrator (or at least someone connected
to the internet) must download and make any dependencies available on the local network beforehand.

To prepare an offline installation, the administrator should run their own (online) installation using the
downloadmstools parameter: this downloads the package dependencies to <directory>, which should
be a fully-qualified path to a location accessible to the client when they run an installation.

start /wait ede_90.exe /q downloadmstools=<directory>

A client can then run an offline installation by pointing their installer at the location of the packages:

ede_90.exe installmstools=<directory>

This command runs a full product install; during which it uses the locally-accessible <directory> to install
the package dependencies.
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Installing silently
You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (installfolder=path), user information, and which
features to install. You must execute the command with superuser permissions.

start /wait install-file.exe /q [parameters]

Examples

• To silently install Enterprise Developer into a directory other than the default:

start /wait ede_90.exe /q InstallFolder=c:\DirectoryName

• If you want to silently install the Eclipse IDE in a location other than the default, execute:

start /wait ede_90.exe /q InstallFolder2=c:\EclipseInstallDirectory

Microsoft Package Dependencies

Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following package: the Windows SDK package.

There is a dependency on the Microsoft Windows SDK if you:

• Produce COBOL .exe or .dll files.
• Call Windows APIs from your COBOL .exe or .dll files.
• Link a C object file into a COBOL .exe or .dll file.
• Call Windows APIs from a C object file linked into a COBOL .exe or .dll file.
• Create MIDL files for OLE RPC.

There is a dependency on the Microsoft Build Tools if you:

• Produce COBOL .exe or .dll files.
• Manage .lib files.
• Convert resource files to object modules.

If you distribute a COBOL product installation to clients that do not have access to the internet, then you
need to have downloaded these packages and placed them in an accessible place on the network before
clients can run an 'offline installation'. The installer includes options to achieve this: downloadmstools
enables you to download the required packages to a specific location; and installmstools enables an
offline client to install the packages from a local network location.

If you do not use any of the features described above, you can use an install parameter (skipmstools=1)
that will skip the download and installation of these dependencies.

All of these installation options are discussed in more detail in the Installation Options topic for your
product.

One of the final steps of the installation process configures the downloaded and installed package versions
for use in your COBOL environment. You can view these versions using the Windows SDK Configuration
Utility - see Managing the Microsoft Build Tools and Windows SDK Packages. This utility also enables you
to specify alternative versions should you need to depend on a specific package other than the one
downloaded, or one stored in a non-default location.

On UNIX

Installing as an Upgrade

This release works concurrently with the previous version of Micro Focus Enterprise Developer UNIX
Components, so you do not need to uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer UNIX Components installer with the –installlocation option:
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1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Preserving Product Configuration

The following information applies when you are upgrading from releases 6.0, 7.0, or 8.0.

If you install this release to the same install location as release 6.0, 7.0, or 8.0, the product in the current
location is moved to a backup directory name.

For example, if the 7.0 product is installed in the default install location, /opt/microfocus/
EnterpriseDeveloper, during the installation process it is moved to /opt/microfocus/
EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS. The new release will be installed in /opt/
microfocus/EnterpriseDeveloper. The backup location will store your original installation along with
any files you deployed to that directory. It will also contain any configuration files you modified post-install.

When installing 9.0 the installer moves a number of specific configuration files to a different configuration
location and symbolically links them back to the new release install location. The configuration location will
be one of the following:

• The default config location is /opt/microfocus/config/.
• For non-root installation, the default location is $HOME/microfocus/config/.
• To specify your own configuration location, run the setup file with the following command-line option: -

mfconfiglocation=[location]

The setup file creates a directory in the configuration location using a 5-digit checksum of the $COBDIR
path. This is so that each configuration location is unique to each product installation. The configuration
files and directories are then placed in this COBDIR checksum directory. In the following example, the
install location generates a checksum of 39082.

The file /opt/microfocus/config/39082/COBDIRlocation.txt details the COBDIR the
configuration area is associated with.

If you have changed any other files in the original installation, you need to be copy these manually from the
backup directory, /opt/microfocus/EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS, into the
install location after the upgrade installation is complete.

You can access the configuration area from $COBDIR/etc/config.

Currently, the setup file only moves the following files and directories, where applicable:

Source Destination

$COBDIR/etc/mfds /opt/microfocus/config/39082/mfds/mfds

$COBDIR/etc/ccsid /opt/microfocus/config/39082/config/
ccsid

$COBDIR/etc/secrets /opt/microfocus/config/39082/secrets
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Source Destination

$COBDIR/bin/mf370ctl.cfg /opt/microfocus/config/39082/config/
mf370ctl.cfg

$COBDIR/bin/CCI.INI /opt/microfocus/config/39082/config/
CCI.INI

$COBDIR/deploy/.mfdeploy /opt/microfocus/config/39082/
deploy/.mfdeploy

$COBDIR/etc/cas/CTFesjcl.cfg /opt/microfocus/config/39082/cas/
CTFesjcl.cfg

$COBDIR/etc/cas/dfhdrdat /opt/microfocus/config/39082/cas/
dfhdrdat

$COBDIR/etc/commonwebadmin.json /opt/microfocus/config/39082/escwa/
commonwebadmin.json

$COBDIR/etc/mfdsacfg.xml /opt/microfocus/config/39082/mfds/
mfdsacfg.xml

$COBDIR/etc/mfdsacfg.dat /opt/microfocus/config/39082/mfds/
mfdsacfg.dat

$COBDIR/etc/mf-client.dat /opt/microfocus/config/39082/mfds/mf-
client.dat

$COBDIR/etc/mf-server.dat /opt/microfocus/config/39082/mfds/mf-
server.dat

$COBDIR/etc/cobol.dir /opt/microfocus/config/39082/config/
cobol.dir

$COBDIR/etc/cobopt /opt/microfocus/config/39082/config/
cobopt

$COBDIR/etc/cobopt64 /opt/microfocus/config/39082/config/
cobopt64

$COBDIR/etc/cobjvm.cfg /opt/microfocus/config/39082/config/
cobjvm.cfg

$COBDIR/etc/cobutf8.cfg /opt/microfocus/config/39082/config/
cobutf8.cfg

$COBDIR/etc/default.tcf /opt/microfocus/config/39082/config/
default.tcf

$COBDIR/etc/mfescache.cfg /opt/microfocus/config/39082/config/
mfescache.cfg

$COBDIR/etc/dsdef.cfg /opt/microfocus/config/39082/config/
dsdef.cfg
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Micro Focus Enterprise Developer UNIX Components Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_9.0_platform -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

Installing using the TMPDIR environment variable

By default, the product installer uses /tmp for temporary files and log files during installation. If /tmp is not
available on your system you can set the environment variable TMPDIR to an alternative location:

TMPDIR=/home/user/tmp
Export TMPDIR

Then run the installation as normal.

Note:

The TMPDIR setting is lost when the installer is elevated to root user within the installer. This occurs
when you run the installer as a non-root user, and are prompted for the root password during the
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installation process. Micro Focus recommends that you log in as root, set TMPDIR and then run the
installer. If you use sudo to run the installer, then use the following command-line syntax:

sudo TMPDIR=$TMPDIR setup…

or:

sudo TMPDIR=/home/user/tmp setup…

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus Customer Support Documentation Web

site for any documentation updates.

Configuring Enterprise Developer
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

On Windows

Using an X Server on Windows

Some features of Enterprise Developer for Eclipse on Windows require an X Server installation such as
Micro Focus OpenText™ Reflection Desktop for X or Micro Focus ViewNow X.

Managing the Microsoft Build Tools and Windows SDK Packages

There are a number of COBOL development features that depend on the Microsoft Build Tools and
Windows SDK packages. By default, the product installer downloads and installs these packages to their
default locations. The installer then sets your COBOL environment to depend on those downloaded
versions.

You can use the Microsoft Build Tools and Windows SDK Packages configuration utility - cblms - to view
which versions are in use, and also configure your COBOL environment if you require something other
than the standard usage.

There is an option within the product installer to skip the installation of the default packages
(skipmstools=1); however, this does skip both packages, so make sure that you do already have the
package(s) that you require before setting this - see Microsoft Package Dependencies for details on the
package(s) you may require.

The Microsoft Build Tools and Windows SDK Configuration Utility

Use the cblms command line utility to view and set the package versions in effect for your COBOL environment.
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Important: If you are updating or clearing package versions, you must run this utility from a command
prompt with administrative privileges.

Syntax:
cblms <option>

Parameters:

Note: <option> settings are case insensitive.

<option> can be one of:

-U
Updates the COBOL environment to use the latest versions of the Microsoft Build Tools
and SDK packages that are located in the default folders. Any open IDE instance or
command prompt must be restarted before these changes take effect.

-U<ms-pkg>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the default folder. Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the default folder.Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<path>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-U<ms-pkg>:<path>?<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-L
Lists all versions of the Microsoft Build Tools and SDK packages that are located in the
default folders.

-L<ms-pkg>
Lists all versions of a particular package type that are located in the default folder.

-L<ms-pkg>:<path>
Lists all versions of a particular package type that are located in the (non-default) folder
specified.

-Q
Displays the versions currently in use by the COBOL environment.

-Q<ms-pkg>
Displays the version of the selected package type that is currently in use by the COBOL
environment.

-R
Clears all version information. (Only use this option when instructed to by Customer Care.)

-H
Displays the available command line options.
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Legend:

<ms-pkg> <ms-pkg> can be one of S or SDK for the Microsoft SDK, or B or BT for the Microsoft Build
Tools.

<path> <path> is the path in which to locate packages that are not installed to the default location for
their package type.

<version> <version> is the package version with which to update when the latest version is not the one
required. When specifying version, it must be in the form:

• n.n.n.n for a Windows SDK
• n.n.n for Build Tools
• n for list ID - the list ID is displayed using cblms -L.

The following example updates the COBOL environment to use version 10.0.17134.0 of
the Windows 10 SDK, installed in C:\WinSDK\10.

cblms -USDK:C:\WinSDK\10\10.0.17134.0

Viewing the Product Help

Enterprise Developer is configured to display the product help available online on the Micro Focus
Customer Care website: https://www.microfocus.com/en-us/support/documentation/.

You can view the Enterprise Developer product help in one of the following ways:

Choose whether to view the help online or locally

You can configure Eclipse to show the Enterprise Developer help either online or locally:

1. In Eclipse, click Window > Preferences > Micro Focus > Help.
2. Either disable or enable Use online documentation, depending on whether you want to see the

documentation locally or online.

Online help (default)

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Enterprise Developer help.

Note: Ensure that you have an up-to-date version of your browser.

Local help

1. Configure Eclipse to use local help as detailed above.
2. Access the local help in one of the following ways:

• Click Help > Help Contents to open the Help Viewer, then open the Micro FocusMicro Focus-
branded documentation.

• Alternatively, press F1 inside the editor or after clicking a dialog within the UI.

Repairing on Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
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Important: Before performing a repair of the installation, Micro Focus recommends that you create
backups of any configuration files of the product that you might have changed.

To repair your installation:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer Micro Focus
Analysis Services Integration, and Micro Focus License Administration. Uninstalling only Enterprise
Developer does not automatically uninstall the Micro Focus License Administration or any of the
prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

On UNIX

Configuring the Remote System Explorer Support

Note: The following only applies if you are using Micro Focus Enterprise Developer UNIX
Components with Enterprise Developer for Eclipse.

The remote development support from the Eclipse IDE relies upon Micro Focus Enterprise Developer UNIX
Components running on the UNIX machine and handling all requests from the IDE for building and
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debugging programs. Micro Focus Enterprise Developer UNIX Components provides a UNIX daemon, the
Remote Development Option (RDO) daemon, which initiates the RDO as Eclipse clients connect to it.
Whichever environment is used to start the RDO daemon will be inherited for all servers and hence all build
and debug sessions.

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.

Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• A version of Perl.
• A version of Java 8 or later.
• The as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable.

The daemon can be run with or without parameters. If no parameters are specified, the process relies on
the default values in $COBDIR/remotedev/rdo.cfg.

Use the following syntax to start the daemon (with super-user authority) on the remote host:

$COBDIR/remotedev/startrdodaemon [<port> <low port>-<high port>] 

where:

• <port> is the port number that the daemon should use to listen for connections from Eclipse. If no value
is given, it will default to the value specified in $COBDIR/remotedev/rdo.cfg; the default value on
installation is 4075.

Example: To start the daemon listening on port 4999:

$COBDIR/remotedev/startrdodaemon 4999

This command will override the default port in rdo.cfg.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine. If no values are given, the range defaults to that
specified in $COBDIR/remotedev/rdo.cfg; the default range on installation is 10000-10003.

Example: To instruct the daemon (on port 4999) to instantiate servers using a range of ports
4090-4993:

$COBDIR/remotedev/startrdodaemon 4999 4090-4993

This command will also override the default ports in rdo.cfg.

If the server has an active firewall, it is important that these ports are open in the firewall settings. You can
use the configrdo utility to set the default ports in rdo.cfg to ones already open in the firewall. If you
are running on Red Hat 7.2 (or later) or CentOS 7.2 (or later), you can also use the utility to open the
required ports in the active firewall. See Configuring the firewall for more information.

Stopping the Daemon

To stop the daemon, type the following command with super-user authority:

$COBDIR/remotedev/stoprdodaemon <port>

Enabling SHIFT-JIS

By default, support for the character encoding for the Japanese language, Shift-JIS, is not available on
Ubuntu and on RedHat OS version 8 or later.
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You need to generate the Shift JIS locale on your machine to be able to execute Shift-JIS applications on
these platforms. You can do this as follows:

1. On RedHat 8, ensure that the glibc-locale-source package is installed.
2. Execute the following command with superuser rights in order to generate a Shift-JIS locale using the

charset:

sudo localedef -f SHIFT_JIS -i ja_JP ja_JP.sjis

3. Set the COBUTF8 environment variable to the generated Shift-SJIS locale and LANG to a UTF8 locale:

export COBUTF8=ja_JP.sjis
export LANG=ja_JP.UTF-8

4. Run the cobutf8 utility:

cobutf8 <command>

See your product documentation for more details about cobutf8.

Repairing on UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Before performing a repair of the installation, Micro Focus recommends that you create backups of any
configuration files of the product that you might have changed.

Uninstalling

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper9.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Enterprise Developer for Eclipse (UNIX)

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
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3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

System Requirements for Enterprise Developer for Eclipse (UNIX)

Hardware Requirements for Enterprise Developer for Eclipse

Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x86-64
running Red
Hat Linux

Micro Focus 1.82 GB 7.28 GB 3.6 GB 50 MB

x86-64
running SUSE
SLES

Micro Focus 1.52 GB 6.1 GB 3 GB 50 MB

System Z
running SUSE
SLES

Micro Focus 888 MB 3.55 GB 1.78 GB 50 MB

x64 running
Amazon Linux
2

Micro Focus 1.46 GB 5.84 GB 2.92 GB 50 MB

x64 running
Ubuntu

Micro Focus 1.49 GB 5.96 GB 2.98 GB 50 MB

x86-64
running Rocky
Linux

Micro Focus 1.82 GB 7.28 GB 3.6 GB 50 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.

Software Requirements

The setup file requires that the following software and libraries are installed before you start the installation,
and that certain environment variables are set.

• Software required by the setup file
• Libraries required by the setup file
• Required environment variables
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• Software installed by the setup file
• Requirements for running the product
• License Manager requirements

Software required by the setup file

The following software must be installed in advance:

• Java versions 11 or later from Adoptium (such as the Adoptium OpenJDK Temurin 17 (LTS) with
HotSpot) and Oracle are required for Enterprise Developer for Eclipse.

• The unzip utility.
• The "awk", "ed", "ps", "sed", tar", "sed", and "which" utilities must be installed and added to the PATH.
• If SELinux is installed and you plan to use anything other than core COBOL functionality, or plan to use

Enterprise Server within an environment with ASLR enabled, the "SELINUX" configuration must be
disabled. To do this, set SELINUX=disabled in /etc/selinux/config.

Libraries required by the setup file

The 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating Systems for this
product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

Library Bitism Platform

32-
bit

64-
bit

SUSE 121 SUSE 151 Red Hat 7 Red Hat 8 Ubuntu
20.4

Amazon
Linux 2

glibc2 X X X X X

libgcc X X X X X

libgc1c2 X X

libstdc++ X X X X X

glibc-locale3 X X X X

libXtst6 X X X X

libXtst X X X X

glibc-devel X X X

gtk3 X X7 X7 X7

PackageKit-
gtk3

X X7 X7 X7

libcanberra-
gtk3

X X7 X7 X7

webkitgtk3 X X7 X7

webkit2gtk3 X X7

xterm Any
versi
on

Any
versi
on

X X X X X X

unzip Any
versi
on

Any
versi
on

X X X X
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Library Bitism Platform

32-
bit

64-
bit

SUSE 121 SUSE 151 Red Hat 7 Red Hat 8 Ubuntu
20.4

Amazon
Linux 2

libgnome X X

libelf-
devel-0.137-8
.19**

X

libelf1-0.137-
8.19**

X

libelf1-32bit-0.
137-8.19**

X

libgtk-3-0 X X7 X7 X

gtk3-tools X X7 X7

gcc45 X X X X X X X

cpp4 X X X X

ld4 X X X X X

libnotify-tools6 X X X X

libnotify X X

libjasper1 X X X

libjasper4 X X

Note:

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 1On SUSE 12 or 15, you can only install the 64-bit version of Enterprise Developer. The glibc-

locale-32bit library is still required by the SafeNet licensing components.
• * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the

GNU Project Debugger) can be installed from the install media for your OS.
• 2The glibc-locale-32bit library is only required if you want to install the SafeNet licensing

components. If this is present, the installer installs and configures both SafeNet and AutoPass
licensing. If glibc-locale-32bit is not installed, the installer only installs AutoPass licensing.

• 3On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 4On Red Hat, these libraries are required to enable COBOL and PL/I to compile.
• 5On Red Hat, only the 64-bit gcc libraries are required.
• 6For SUSE 12 and later, you might need to install the Notifications Library tools (libnotify-tools).

This is to enable notifications to be displayed by the notify-send tool when starting Enterprise
Developer for Eclipse from a desktop icon. Execute the following command to install the libnotify-
tools library:

zypper install libnotify-tools

• 7The minimum GTK support required is 3.22. Certain platforms meet this requirement without the
need of installing the libraries manually; for example Red Hat 7.4 and SUSE 12 SP3.

• **Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

Required environment variables

Before you start the installation, you need to set the environment as follows:
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• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

Software installed by the setup file

• The setup file installs Enterprise Developer and the 64-bit version of Eclipse 4.24 (2022-06). After the
installation, you can install Enterprise Developer as a plug-in into other Eclipse 4.24 (2022-06)
instances available on the same machine - see Installing Enterprise Developer into other instances of
Eclipse.

Note: On SUSE platforms, you can only use the 64-bit version of Eclipse to produce 64-bit
applications; on other 64-bit platforms, you can use Eclipse to produce both 32-bit and 64-bit
applications.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
always installed by default. Use your UNIX/Linux installation media to install it.

Requirements for running the product

• Java 11 (64-bit) or later is required to run the Eclipse IDE. The recommended version is Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Windows, the installer automatically installs Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Linux, you need to install Java before you install this
product. You can download Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web
site and unpack the archive anywhere on your machine.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager

before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.
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2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Installation on UNIX and Linux (Known Issues)

Installing on Linux

On Linux, the RPM installer for Enterprise Developer for Eclipse installs a 64-bit version of Java. When you
start the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not
be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux which
prevents you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Enterprise Developer.

Installing on Ubuntu 10.10 and later

Every version of Ubuntu starting with 10.10 comes with a setting that prevents an application from using
ptrace to attach to another process. This prevents the PL/I debugger from attaching to user processes, and
therefore debugging fails. To prevent this problem, disable the offending setting as follows before installing
Enterprise Developer:

1. Using any text editor, open the /proc/sys/kernel/yama/ptrace_scope file.
2. Set pctrace=0.

For more information, see Debugging applications that run on Ubuntu (ptrace restriction).

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
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The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing the software
Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_edeclipse_9.0_platform

2. Run the setup file with superuser permissions:

./setup_entdev_edeclipse_9.0_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR). A full version of Eclipse, with the Micro Focus plugins already installed, is present in the
$COBDIR/eclipse directory.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_edeclipse_9.0_platform -installlocation="full path of new 
location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note: See Installing in an Ubuntu Docker Image Running on Windows 11 for specific installation
instructions for this scenario.

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
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running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

. /setup_entdev_edeclipse_9.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass

• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

Setting up the environment
If you have installed the product to a directory other than the default one, you need to set the environment
as described below.

Note: The default directory is /opt/microfocus/EnterpriseDeveloper.

1. To set up your product, execute:

. <product-install-dir>/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Starting the product
To start Eclipse:
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• If you are using a GUI interface, double-click the product icon (automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh

• If you are using a non-GUI interface, such as a terminal emulator, type the following from a command
prompt:

eclipse

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus

Infocenter
• Installing and licensing Micro Focus Rumba - available in the product Help and in the Micro Focus

Infocenter
• Installing into other instances of Eclipse - available in the product Help and in the Micro Focus

Infocenter
• Installing the Mainframe Components, - Mainframe Access Server, Application Workflow Manager into

IDz, z/Server - available in the product Help and in the Micro Focus Infocenter
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus

Infocenter

Click here to see this information on the Product Documentation pages on Micro Focus Customer Care.

Installing in an Ubuntu WSL2 on Windows
The following instructions apply when you install the product inside Ubuntu 20.04 WSL2 on Windows.

Prerequisites

You need to have a new instance of a Ubuntu 20.04 WSL2 running on Windows.

1. In Windows, open the Ubuntu WSL2 console.
2. Download and install Java. Eclipse supports versions 11 through to 15.
3. Create a symbolic link in Ubuntu from java-install-dir/bin/java to /usr/bin/java.

This enables the installer to locate Java when you run commands as the root user.
4. Execute the following commands to install the prerequisites for Enterprise Developer:

sudo apt-get update
sudo apt-get install libgc1c2
sudo apt-get install libgtk-3-0
sudo apt-get install libnotify-bin
sudo apt-get install unzip
sudo apt-get install xterm
sudo apt-get install nasm
sudo apt-get install gcc

Installing the product

• To install the product, execute:

sudo ./setup_enterprisedeveloper_deveclipse_8.0_ubuntu_x64
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• Follow the rest of the instructions in these Install Notes to license the product, and to set the
environment.

Known issues in Ubuntu running on Windows 11

• The Eclipse icon in the Windows Start menu does not work.
• If you reset Ubuntu 20.04 WSL2, the Micro Focus icons created in Ubuntu are not removed from the

Start menu.

Installing as an upgrade
This release works concurrently with the previous version of Enterprise Developer, so you do not need to
uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Enterprise Developer installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Preserving Product Configuration

The following information applies when you are upgrading from releases 6.0, 7.0, or 8.0.

If you install this release to the same install location as release 6.0, 7.0, or 8.0, the product in the current
location is moved to a backup directory name.

For example, if the 7.0 product is installed in the default install location, /opt/microfocus/
EnterpriseDeveloper, during the installation process it is moved to /opt/microfocus/
EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS. The new release will be installed in /opt/
microfocus/EnterpriseDeveloper. The backup location will store your original installation along with
any files you deployed to that directory. It will also contain any configuration files you modified post-install.

When installing 9.0 the installer moves a number of specific configuration files to a different configuration
location and symbolically links them back to the new release install location. The configuration location will
be one of the following:

• The default config location is /opt/microfocus/config/.
• For non-root installation, the default location is $HOME/microfocus/config/.
• To specify your own configuration location, run the setup file with the following command-line option: -

mfconfiglocation=[location]

The setup file creates a directory in the configuration location using a 5-digit checksum of the $COBDIR
path. This is so that each configuration location is unique to each product installation. The configuration
files and directories are then placed in this COBDIR checksum directory. In the following example, the
install location generates a checksum of 39082.

The file /opt/microfocus/config/39082/COBDIRlocation.txt details the COBDIR the
configuration area is associated with.

110 | Installation



If you have changed any other files in the original installation, you need to be copy these manually from the
backup directory, /opt/microfocus/EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS, into the
install location after the upgrade installation is complete.

You can access the configuration area from $COBDIR/etc/config.

Currently, the setup file only moves the following files and directories, where applicable:

Source Destination

$COBDIR/etc/mfds /opt/microfocus/config/39082/mfds/mfds

$COBDIR/etc/ccsid /opt/microfocus/config/39082/config/
ccsid

$COBDIR/etc/secrets /opt/microfocus/config/39082/secrets

$COBDIR/bin/mf370ctl.cfg /opt/microfocus/config/39082/config/
mf370ctl.cfg

$COBDIR/bin/CCI.INI /opt/microfocus/config/39082/config/
CCI.INI

$COBDIR/deploy/.mfdeploy /opt/microfocus/config/39082/
deploy/.mfdeploy

$COBDIR/etc/cas/CTFesjcl.cfg /opt/microfocus/config/39082/cas/
CTFesjcl.cfg

$COBDIR/etc/cas/dfhdrdat /opt/microfocus/config/39082/cas/
dfhdrdat

$COBDIR/etc/commonwebadmin.json /opt/microfocus/config/39082/escwa/
commonwebadmin.json

$COBDIR/etc/mfdsacfg.xml /opt/microfocus/config/39082/mfds/
mfdsacfg.xml

$COBDIR/etc/mfdsacfg.dat /opt/microfocus/config/39082/mfds/
mfdsacfg.dat

$COBDIR/etc/mf-client.dat /opt/microfocus/config/39082/mfds/mf-
client.dat

$COBDIR/etc/mf-server.dat /opt/microfocus/config/39082/mfds/mf-
server.dat

$COBDIR/etc/cobol.dir /opt/microfocus/config/39082/config/
cobol.dir

$COBDIR/etc/cobopt /opt/microfocus/config/39082/config/
cobopt

$COBDIR/etc/cobopt64 /opt/microfocus/config/39082/config/
cobopt64

$COBDIR/etc/cobjvm.cfg /opt/microfocus/config/39082/config/
cobjvm.cfg

$COBDIR/etc/cobutf8.cfg /opt/microfocus/config/39082/config/
cobutf8.cfg
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Source Destination

$COBDIR/etc/default.tcf /opt/microfocus/config/39082/config/
default.tcf

$COBDIR/etc/mfescache.cfg /opt/microfocus/config/39082/config/
mfescache.cfg

$COBDIR/etc/dsdef.cfg /opt/microfocus/config/39082/config/
dsdef.cfg

Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_edeclipse_9.0_platform -installlocation="full path of new 
location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA
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After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus Customer Support Documentation Web

site for any documentation updates.

Configuring Enterprise Developer
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Configuring the Environment for Developing RDBMS Applications on
UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Enabling SHIFT-JIS
By default, support for the character encoding for the Japanese language, Shift-JIS, is not available on
Ubuntu and on RedHat OS version 8 or later.

You need to generate the Shift JIS locale on your machine to be able to execute Shift-JIS applications on
these platforms. You can do this as follows:

1. On RedHat 8, ensure that the glibc-locale-source package is installed.
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2. Execute the following command with superuser rights in order to generate a Shift-JIS locale using the
charset:

sudo localedef -f SHIFT_JIS -i ja_JP ja_JP.sjis

3. Set the COBUTF8 environment variable to the generated Shift-SJIS locale and LANG to a UTF8 locale:

export COBUTF8=ja_JP.sjis
export LANG=ja_JP.UTF-8

4. Run the cobutf8 utility:

cobutf8 <command>

See your product documentation for more details about cobutf8.

Viewing the Product Help
Enterprise Developer is configured to display the product help available online on the Micro Focus
Customer Care website: https://www.microfocus.com/en-us/support/documentation/.

You can view the Enterprise Developer product help in one of the following ways:

Choose whether to view the help online or locally

You can configure Eclipse to show the Enterprise Developer help either online or locally:

1. In Eclipse, click Window > Preferences > Micro Focus > Help.
2. Either disable or enable Use online documentation, depending on whether you want to see the

documentation locally or online.

Online help (default)

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Enterprise Developer help.

Note: Ensure that you have an up-to-date version of your browser.

Local help

1. Configure Eclipse to use local help as detailed above.
2. Access the local help in one of the following ways:

• Click Help > Help Contents to open the Help Viewer, then open the Micro FocusMicro Focus-
branded documentation.

• Alternatively, press F1 inside the editor or after clicking a dialog within the UI.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Before performing a repair of the installation, Micro Focus recommends that you create backups of any
configuration files of the product that you might have changed.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:
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1. Execute as root the Uninstall_EnterpriseDeveloper9.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus Customer Care.

Important: The SafeNet Sentinel licensing system has been deprecated and will be not available in
this product starting with the next major release - release 10.0.

The SafeNet Sentinel licenses will not be supported after release 9.0. You can only use AutoPass
licenses from release 10.0.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
However, it is not necessary to switch to AutoPass licenses unless you are adopting release 10.0.
Contact Micro Focus Customer Care for further information.

To start Micro Focus License Administration

Windows: To start the GUI Micro Focus License Administration

Windows 10 From your Windows desktop, click Start > Micro Focus License Manager > License
Administration.

Windows 11 Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start License Administration.

Windows: To start the command-line Micro Focus License Administration tool

1. At a command prompt, navigate to:

C:\Program Files (x86)\Micro Focus\Licensing

2. Type cesadmintool.bat, and press Enter.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension for Sentinel RMS licenses or an .xml extension for
AutoPass licenses) or an authorization code which consists of a string of 16 alphanumeric characters
(Sentinel RMS licenses only). You need to install AutoPass licenses into the existing Micro Focus License
Administration tool, and not in the AutoPass License Server.
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If you have a license file

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic or .xml).

• Drag and drop the license file from Windows Explorer to the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Click Browse next to the License file field.
4. Select the license file (which has an extension of either .mflic or .xml), and then click Open.
5. Click Finish to install the license.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Manual License Installation option by entering 4.
3. Enter the name and location of the license file.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code
Note: Authorization codes are only available with Sentinel RMS licensing.

Authorizing your product when you have an Internet connection
Note:

• This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
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4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. On the Install tab, click Manual Authorization.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the Customer Care Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus Customer Care Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

Windows: To use the command-line Micro Focus License Administration tool

In order to authorize your product from the command-line Micro Focus License Administration tool you
must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.
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1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
7. Enter the name and location of the license file.

UNIX

In order to authorize your product you must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus Customer Care.
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Updates and Customer Care
Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Customer Care
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• Product Updates on Software Licenses and Downloads, where you can download fixes and
documentation updates.

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter .

2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any
patch updates.

6. Click Download on the relevant row.
• The Examples and Utilities section of the Micro Focus Customer Care Web site, including demos and

additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

• The Support Resources section of the Micro Focus Customer Care Web site, that includes
troubleshooting guides and information about how to raise an incident. Go to https://
supportline.microfocus.com/supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Portal.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product. See Micro Focus Channel on
YouTube.

• Micro Focus webinars: https://www.microfocus.com/en-us/resource-center/webinar.
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Information We Need
If your purpose in contacting Micro Focus is to raise a support issue with Customer Care, you should
collect some basic information before you contact us, and be ready to share it when you do.

Click here to see the Preparing to Raise a Support Case topic on the Product Documentation pages on
Micro Focus Customer Care.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus Customer
Care, your support representative might request that you provide additional debug files (as well as source
and data files) to help us determine the cause of the problem. If so, they will advise you how to create
them.
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Copyright and Disclaimer
© Copyright 2023 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/).
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